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Welcome to Malcolm 

THE MALCOLM USEll'S GUIDE DESCRIBES HOW TO L'STAU. ASD USE MALCOLM, 

ANX 

Window System display server, developed by Apple, for the Macintosh® 

family of computers. To help you use this guide effectively, this Preface 

summarizes the contents of each chapter and appendix and suggests 

alternative approaches to reading this book depending on your knowledge of 

computers and network communications. A list of related publications and 

resources is also included should you need additional information about the X 

Window System. 

About This Guide 



ii About This Guide 

Who should read this guide 
Anyone who plans to install and use Malcolm should consult this guide. 
Malcolm confonm to the latest version ofX (version 11, release 3); however, 
it contains many enhancements made possible by the Macinto.5h method for 
interacting with users (formally called the Mactntosh User Interface). 
Consequently, anyone using Malcolm should read or browse through this 
guide to learn about the product's special features. 

Because X users have little in common, with respect to education, knowlege 
of X, and profession, this user's guide tries to accommodate its readers' 
divergent needs. The next section, "How to use this guide,• suggests to 
approaches to reading this manual, based on your technical knowledge and 
experience with X. 

Although this guide teaches you how to install and use Malcolm, it will not 
be sufficient for people who have never used X programs before. Since X 
applications, called clients, run on other mini- or mainframe computers 
under operating systems like UNIX® or VMS™, you must learn how to issue 
commands to run clients and perform other necessary work on those 
systems. Consult the documentation written for the systems on which 
your clients reside for more information. In addition, •other Publications and 
Resources• at the end of this Preface lists some books devoted to using X on 
UNIX and other operating systems. 

How to use this guide 

Your experience with X, computers, and networks will determine the way 
you should use the Malcolm User's Guide. Ch0o.5e one of the two suggested 
approaches that best suits you, depending on your level of experience in 
these areas. 

Apple Confidential 5/30/89 
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For the beginner 

For the expert 

Summary of contents 
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If you haven't installed Malcolm, go to the Malcolm Installatton Booklet 
<currently Chapter 7Jfor step-by-step instructions. Next, read 
Chapter 1 if you're not too familiar with the X Window System. Chapter 1 
briefly covers what X is, how it works, and how Malcolm differs from 
traditional implementations of X. It also contains a summary of Malcolm 
features, which you can read or scan, at your option. Then you'll be ready to 
read Chapter 2, which explains the essentials you need to know to run clients 
on a Macintosh. After learning the basics, you can browse through the other 
chapters, at your convenience, to learn about other handy, but nonessential, 
features. See the summary of contents, below, for synopses of the 
remaining chapters and appendices. 

People with technical backgrounds or extensive X experience can bypass 
much of the introductory material. Thus, after installing Malcolm, read 
"Introducing Malcolm" in Chapter 1 to learn how Malcolm differs from 
standard X implementations. Chapter 2 is tutorial. Except for the "Opening 
Malcolm" and "Quitting Malcolm" sections, you can get the same 
information, expanded upon, from Chapter 3. Essentially, you'll want to glean 
what you need from the first two chapters and then concentrate on the 
remaining chapters and appendices, where specific features are documented 
in detail. 

This section summarizes the contents of the chapters and appendices in this 
guide. 

• Chapter 1, "Malcolm Overview,• briefly describes the X Window System 
and then introduces Malcolm. It defines the major components of 
Malcolm and explains how Malcolm works with a visible or invisible root 
window and with multiple screens. Finally, it presents an overview of 
Malcolm features, including illustrations of menus and the dialog boxes 
that appear. 

• Chapter 2, •Getting Started," covers the basic things you need to know to 
function in an X environment using Malcolm. It describes how to open 
Malcolm, log on to a host and start a terminal emulator, log off the host 
and exit from Malcolm. 

About This Guide iii 



Symbols and conventions 
in this guide 

iv About This Guide 

• Chapter 3, "Using Remote Commands," describes how to create, execute, 
and edit remote commands using the Remote menu and the Remote 
Command window. 

• Chapter 4, "Handling Windows,• explains how to move, resize, and iconify 
windows. It explains how to select different window styles and how to 
select a default window style and set preferences for the root window. 

• Chapter 5, "Managing Fonts and Color,• describes procedures for adding 
and removing fonts and colors, creating aliases for font names, scrolling, 
and many other features supplied by the Font Director and the Color 
Namer. 

• Chapter 6, "Troubleshooting,• explains how to recover from errors that 
occur. 

• Chapter 7, "Installation,• states system requirements and illustrates 
sample network configurations for Malcolm. It describes what comes in 
the Malcolm product package, how to install Malcolm and two 
communications protocols: MacTCP and ADSP. (Thfs chapter 
could become a separate document. Final format 
of fnstallat ton stf 11 to be de term fned.) 

• Appendix A, "Malcolm Versus Other X Servers,• states the differences 
between Malcolm and conventional X servers. 

• Appendix B, "The Malcolm Window Manager," identifies notable features 
of the Malcolm Window Manager. 

• Appendix C, "Bitmap Distribution Format 2.1," contains a copy of the X 
Consortium document that describes the format of BDF files. 

• Appendix D, "X Logical Font Description Conventions,• contains a copy 
of the X Consortium document that specifies the format of X font 
names. 

• Appendix E, "Character Conversion Charts," contains matrices of ISO Latin 
1 characters and Macintosh Extended ASOI characters and describes how 
Malcolm converts characters from one code set to the other. 

This guide includes special elements in the text to highlight important or 
different information. 

+ By the way: Text in this format are notes that present additional 
information or interesting sidelights. 

Apple Confidential 5/30/89 
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6 Important Text labeled "important" cautions you against doing things that might be 
inconvenient or troublesome, but not damaging to your hardware or 
software. 6. 

Tenns in boldface are defined in the glossary. 

A special typeface indicates characters you should type. 

It looks like this. 

Other publications and resources 

Information about the X Window System is widely available from a variety 
of sources. 

For a tutorial on starting a server and running standard clients under the 
UNIX operation system, read X Window System User's Guide, Volume Three, 
by O'Reilly & Associates, Inc., Nev.ton, ~tassachusetts, 1988. This document 
is based on revision 2 of Xl 1, but still contains much useful information, 
including command reference pages for clients and an appendix illustrating 
standard fonts 

An entire suite of documents exist for those interested in the A/L'X@ version 
of X. A/UX is a System V-based version of the U~IX operating system for 
the Macintosh. The user's guide, available from Apple, is called the X Window 
System User's Guide for AIUX. For a complete description of A/UX manuals as 
well as part numbers and ordering information, see the Road Map to AllJX 
Documentation. 

Subscribers to Usenet can join or monitor the news group, comp.windows.x, 
an on-line forum for news and discussion of the X Window System. Ask 
your network administrator for information about Usenet. 

About This Guide v 
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Malcolm Overview 

IN EARLY 1984, TWO GROUPS AT MIT EMBARKED ON PROJECTS THAT REQL111ED 

people to work with computers in an entirely different way. In one case, 

students needed to run microcomputer applications, like spreadsheet and 

word processing programs, while simultaneously running programs on 

different ho.sts in remote locations. An important requirement was the 

ability to display graphics. The individuals who assumed this task devised an 

innovative solution in just two years. Their development effort, which 

included input from major computer manufacturers, culminated in the 

introduction of the X Window System, version 10 release 4, in 1986. In January 

1988, MIT formed a consortium with most of the leading computer and 

workstation companies to continue development of the X Window System 

and to have it adopted as an ANSI standard. In November 1988, the 

consortium distributed version 11 release 3 of X. This chapter introduces you 

to Xl 1R3 and gives you an overview of Malcolm, Apple Computer's version of 

the X server, the specialized software that enables a Macintosh® computer to 

run X applications. 

Chapter 1: Malcolm Overview 



2 Chapter 1: Malcolm Overview 

What is the X Window System? 

The X Window System or X, for short, is a network-based graphics system 
designed to create an enhanced computing environment using the capabilities 
of desktop computers, like the Macinto.sh. X draws graphics, creates 
windows to display and run several applications simultaneously, and enables 
you to access X applications over a network from different makes of 
computers without being affected by incompatible hardware or operating 
systems. 

As Figure 1-1 illustrates, X is also called a window system, or windowing 
environment, because it displays the applications you invoke in windows on 
your screen. Essentially, this process converts your screen into a lot of 
miniature screens on which you can perform many activities rather than just 
one at a time. You can move, resize, and stack these windows, as well as 
reduce them to icons-a handy way to set aside windows without closing 
the applications in them. What's more, an application can also create its own 
windows, but the application controls how they are manipulated and they 
must remain within the boundaries of the application's window. 

• Figure 1-1 Some typical X windows 

Apple Confidential 5/30/89 
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In X parlance, an application is 
called a client. 

X Window System 
structure 

Apple Confidential 

Although you can run X applications on your own microcomputer under an 
operating system that supports them (such as A/UX®), the primary reason 
for using Xis that it lets you access programs remotely, over a network, and 
ensures that they function smoothly and reliably, as if the network weren't 
there. X also isolates different hardware architectures and operating systems 
that would prevent your machine from interacting with another machine in 
order to run an X application. By making the hardware compatible, the same 
program can run on any make of workstation or microcomputer in the 
network. Thus, you can run an application on one machine and display the 
results on another. Hardware compatibility also facilitates balancing the 
workload among network hosts by enabling them to share files. Should one 
host get overloaded, people can shift to other hosts to run their applications. 
Finally, programmers see X as a great advance because it frees them from 
having to rewrite programs in order to transfer them from one type of 
computer to another. 

The designers of X realized these enhanced capabilities through a design that 
assigns the major functions of X to individual components. X functions well 
in a network environment because these components are distributed 
between your Macintosh and the remote host computers on which the 
clients reside, based on a concept called the client/server model Knowing 
something about the different parts of X and how they work together will 
give you a clear picture of what happens when you run an X application. 

X has a twcrpart structure composed of two separate but interrelated 
groups of software that communicate through a protocol. One group of 
programs supports clients (X applications) and the other controls the 
desktop computer on which the clients are displayed. These programs can 
work together on the same system if clients are installed on the machine 
that displays them or be separated over a network if the clients are located 
on different hosts. Figure 1-2 illustrates the relationship of these different 
components, formally referred to as the client/server model. 

Chapter 1: Malcolm Overview 3 



A display is a workstation or desktop 
computer with a keyboard, a 
pointing device, such as a mouse, 
and one or more bit-mapped 
screens. X will support a mouse with 
up to five buttons. 

4 Chapter 1: Malcolm Overview 

• Figure 1-2 The client/server model 

As depicted in the illustration, the X server is always located in a display, 
whereas the two application libraries-Xlib and the X toolkit-reside with 
the clients: either on different hosts or in your own computer. 

X protocol 

X Window System protocol is a low-level graphics description language used 
by clients and the X server in your desktop computer (see next paragraph) to 
exchange information. This protocol establishes rules for composing and 
transmitting packets of instructions used to draw graphic images and 
windows, transmit text, specify colors and fonts, notify when events (such 
as a pressed key or the mouse click) occur, and related matters. 

Apple Confidential 5/30/89 
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X server 

The X server is a multilayer program that runs in your desktop computer and 
controls the flow of information to and from the keyboard, mouse, and 
screen (or screens). It acts as a switchboard, relaying information from 
different clients to the appropriate windows on the screen and from your 
machine to the appropriate client. The language used in this information 
exchange is X protocol. Beyond routing messages, the server performs other 
communications-related services, such as maintaining communications links 
with each client, interpreting network messages, and assembling and 
disassembling X protocol request packets. The server also draws graphic 
images and windows, installs fonts, tracks the cursor and maintains its color, 
size, and shape, maintains a map of color values, and requests services from 
the operating system. 

Xllb 

Xlib is a library of C routines-program segments written in the C 
programming language-that each perform a certain task when called by a 
client program. For example, they enable a client to communicate with a 
server, request that a window be created, draw graphics, respond to output 
from the keyboard or mouse, and so forth. Xlib calls are translated to X 
protocol requests before being transmitted to the server. 

Window manager 

Like any client, the window manager is just another program written with 
the X library, except that, by convention, it has special authority to control 
the layout of windows on the screen. This specialized client enables you to 
move, resize, and stack windows, create new windows, and shrink windows 
to icons. Some window managers enforce a layout policy that specifies 
the sizes and positions allowed for windows and icons. Programmers must 
ensure their clients comply with these policies. 

Chapter 1: Malcolm Overview 5 
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x toolkit 

An X toolkit is a library of subroutines that employs several Xlib drawing 
routines and other functions to produce larger graphic objects, such as 
menus and scroll bars. Programmers use these objeas, called widgets, to 
create the images you see on your desktop. Other toolkit subroutines 
manage and destroy widgets. A toolkit also furnishes tools called intrinsics, 
used to create new widgets. 

Because the way you use X depends on the type of machine and operating 
system you have, giving step-by-step instructions for starting up and using 
X is beyond the scope of this guide. However, a general overview will give 
you an idea of what is common to all implementations of X. It is helpful for 
readers unfamiliar with X. 

In order to display clients on your screen, you must first start up the X 
server which, in a standard X configuration, creates a background, or root, 
window that covers the entire screen. Typically, your .login or .profile file 
will contain a command to start up the window manager, else you must 
type the command yourself. At this point, you can is.sue commands to run 
clients on your own machine or you can log on to other hosts and issue 
remote commands (or their equivalent) to run clients. The client responds by 
sending X protocol packets requesting the X server to draw a window of a 
certain size in a certain location (although you can specify a size and location 
yourselO. The X server interprets these requests and relays them to the 
window manager. If the window manager approves, a window appears on 
your screen. Using this procedure, you can display as many clients as your 
machine will accommodate. 

Apple Confidential 5/30/89 



X supports displays with multiple 
screens. These screens can be color 
or monochrome. 
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Windows and their hierarchy 

As Figure 1-1 shows, windows in X are organized in a hierarchy. The root 
window comprises the first level. In traditional X systems, the root window 
is always vi.sible and covers the entire screen. (If you have more than one 
screen connected, a root window appears in each one.) All other windows are 
subordinate to the root window. Occupying the second level in the hierarchy 
are the top-level client windows: the windows that appear when you start 
up a client. These are the windows you can resize, move around, and 
manipulate in other ways, according to the dictates of the window manager. 
Finally, clients can create their own third or lower-level windows; however, 
by convention, the clients control the manipulation of these windows. In 
Figure 1-1, the keys on the calculator are third-level windows. 

•:• Window disguises: Windows don't always have to look like windows. 
Since, in X, a window is a rectangular object that is sensitive to a mouse 
pointer, clients often draw tiny subwindows that look like menus, 
buttons, scroll bars, and other shapes. When a mouse pointer enters or is 
clicked in one of these subwindows, the client receives the feedback. 

Another important point about the window hierarchy is the restrictions that 
higher-level windows impose on lower-level ones. Since a window i.s 
subordinate to the window that created it, think of the subordinate as the 
child and its creator, the parent. In X, every window has a parent except the 
root window. Accordingly, client windows are children of the root window, 
but are the parents of any lower-level windows their clients create. A child 
always remains within the boundaries of its parent window. Even though a 
child window can be larger than its parent, you will see only the part 
bounded by the dimensions of the parent window. The rest i.s invisible, 
unless the client lets you move the child window around to reveal its hidden 
parts. 

Now that you have a general idea about what X is and how it works, read 
the rest of this chapter to learn about Malcolm, Apple's version of X for a 
Macintosh running the Macintosh operating system. 

Chapter l: Malcolm Overview i 



Introducing Malcolm 

Malcolm is an X server for the Macintosh. By permitting a Macintosh using 
the Macintosh operating system to run X applications, Malcolm combines the 
advantages of X with Macintosh advantages and features. The ability to cut 
and paste text between Macintosh and X applications exemplifies the 
benefits of this combination. What's more, Malcolm adds new features to 
standard X and makes many of the more cumbersome and tedious methods 
for doing things-such as changing fonts and adding new colors-quicker 
and easier. Notwithstanding these enhancements, Malcolm fully conforms to 
the standards published in the Inter-Client Communications Conventions 
Manual (ICCCM) and to the latest version of X version 11, release 3. 

What you get with Malcolm In addition to the X server, Malcolm software includes: 

8 Chapter 1: Malcolm Overview 

• Malcolm Window Manager 

The Malcolm Window Manager allows you to use X windows like 
Macintosh windows. It also supplies a selection of five window styles 
and lets you convert windows into icons. This window manager handles 
windows in rootless mode, a mode in which the root window is 
invisible. Malcolm provides the option to display or hide the root 
window. 

• Malcolm Font Director 

The Font Director displays and sorts X and Macintosh fonts and compiles 
Adobe Bitmap Distribution Format (BDF) files into X fonts. It also 
permits you to assign aliases to long, unwieldy font names. 

• Malcolm Fonts folder 

This folder contains files for a variety of type fonts. Each file contains a 
single font-family variation. For example, one file could contain Courier 12 
point bold and another file, Courier 14 point bold. 

• Malcolm Colors file 

This file contains an array of colors that you can add to, modify, or delete 
using the Malcolm Color Namer. 
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Malcolm is designed to blend in with your Macintosh working environment, 
adding another dimension to your desktop without impeding or limiting 
Macinta;h facilities. While Malcolm is running you can use MultiFinder111 and 
your desk accessories. You can run Macintosh applications and various X 
clients simultaneously. Functions such as cut, paste, save, and quit operate 
the same way, and you can cut and paste text between Macintosh and X 
applications. Malcolm uses the Macintosh method for handling windows 
plus some added features, but gives you the option to use a different 
window manager, too. Like standard X products, Malcolm supplies a variety 
of colors and fonts, but makes them easier to use. For instance, the Color 
Namer shows an example of each color available so that you don't have to 
imagine what they look like. You can create new and remove existing colors, 
change color names, and copy color names into X commands in client 
windows. With the Malcolm Font Director, you can use Macintosh and X 
fonts interchangeably and assign aliases to long, cumbersome font names. 
The font director also provides a variety of methods for sorting fonts. 

Each time you start up Malcolm, it creates a settings document in which 
you can store commands and preferences. If you name and save this file 
when you quit Malcolm, a Malcolm file icon labeled with that name appears 
on the screen. You now have your own personalized X environment to which 
you can return any time by clicking on the file icon. Through these individual 
settings documents, Malcolm enables you to tailor X environments to 
different hosts, clients, types of tasks, or working styles. 

Malcolm offers an alternative to the standard X root window display. 
Although the option for displaying the root window exists, Malcolm is 
preset to hide the root window and display the Macintosh desktop instead. 
Figures 1-3 and 1-4 illustrate both cases. 

Chapter 1: Malcolm Overview 9 
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Invisible root window 

When you launch the Malcolm application, no root window appears. Instead, 
the •About Malcolm• box appears on the screen until Malcolm fmishes 
launching and then the Malcolm menus appear in the menu bar at the top of 
the screen. If MultiFinder is running, a Malcolm icon appears in the upper 
right oomer. As Figure 1-3 shows, the desktop is visible. Since a rott window 
does not appear, this mode of operation is called rootless. Malcolm, by 
default, hides the root window unless a client requires a visible one a you 
select a particular option in the Preferences submenu. Malcolm defaults to 
rootless mode so that you can manipulate X windows like real Macintosh 
windows. Since your desktop is readily accessible. rootless mode also makes 
using Macintosh applications and desk accessaies easier. 

• Figure 1-3 Malcolm on the desktop with the root window invisible 

Visible root window 

Malcolm is preset to create a visible root window if one cl your clients 
requests one. Alternatively, you can set a preference to always or never 
display the root window and save this preference in a settings document. 
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(See Chapter 4 for more information.) Figure 1-4 shows what your desktop 
looks like, assuming that your Macintosh has just one screen attached. (Read 
the next section, •using Multiple Screens,• if you have more than one screen.) 
Usually the root window covers the entire screen unless someone has set a 
preference to make the roct window bigger or smaller. You'll notice that the 
window in Figure 1-4 has a size box in the lower right corner. Although labeled 
•root,• this window is actually a Macintosh window that reveals all or part of 
a logical root window stored in memory. In standard X environments, the 
root window occupies the entire screen and is frozen in that position. It 
cannot be moved to another screen or resized. However, the Macintosh was 
designed to pennit you to move and modify windows. Unfortunately, the 
consequences d moving or resizing a root window that contains client 
windows are unknown because X was not designed to deal with this case. 
Malcolm avoids this uncertainty by creating the actual root window in 
memory and allowing you to view it through a Macintosh window. To see 
how this approach works, try decreasing the size of the Macintosh root­
viewing window. Even though you can't see the whole root window now, 
you can use the scroll bars to move around and view all of it. You can also get 
to things on your desktop more easily. 

• Figure 1-4 Malcolm on the desktop with the root window visible 
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Using multiple screens 

In accordance with X specifications, Malcolm supports single or multiple 
screens. The screem can be color, gray scale, or monochrome in any 
combination. Figure 1-5 illustrates a multiple screen setup. Malcolm 
distinguishes the types of screens attached to your Macintosh by checking 
the System File. 

• figure 1-5 A Macintosh with multiple saeens attached 

If you are familiar with using multiple screem on a Macintosh, you know 
that when you move a window half way between two screens nothing in 
the middle of the window gets lost, despite the physical separation between 
the screem. The screem act as if they are continuous because the Macintosh 
operating system joins multiple screens edge-to-edge into one big screen. 

1·~.i 
'"'-...J' 

(This feature is unique to Macintosh computers.) To see what this ~1 

arrangement looks like, select the Control Panel from the Apple menu (ti) 
and click the Monitors icon. You will see a diagram similar to the one in Figure 
1-6. The screens in the Control Panel should be arranged like the monitors on 
your desk, except with no spaces in between them. 

1··, 
\lY'<"r'"f 
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• Figure 1-6 A control panel diagram of multiple screens 

• .. fJ 
Mouse 

control Penel 

Now draw an imaginary rectangle around all of the screens in your Control 
Panel, like the red one in Figure 1-6. You will notice some blank areas, if the 
screens are different sizes. Malcolm treats the entire contents of this 
rectangle, tnduding the blank areas, as one continuous screen on which it 
can display windows. That's why part of a window can disappear when you 
move it from a taller screen to a shorter one. For example, if you moved a 
window from the top of screen 2 in Figure 1-6 straight across to the blank 
area above screen 1, which is shorter, part of the window would not appear 
until you pull it down into screen 1. The window was always there, but 
Malcolm just couldn't re-create it in thin air. 

In Malcolm, the rooted and rootless modes coexist unless you suspend 
rooted mode by setting the root window option to never. When issuing a 
command to display a client, you can specify whether you want it to appear 
in rooted or rootless mode on either a color or monochrome screen by adding 
a screen number to your command. (See "Starting a Terminal Emulator" in 
Chapter 2 for a complete explanation of issuing remote commands and 
specifying screen numbers.) Table 1-1 supplies a list of screen numbers. 
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• Table 1·1 Screen numbers 

Screen number 

0 

1 

2 

3 

Description 

Monochrome screen, rootle" mode 

Monochrome screen, rooted mode (visible root window) 

Color screen, rootless mode (invisible root window) 

Color screen, rooted mode 

If your Macint06h has more than one screen of the same type attached to it, 
Malcolm will display the client on the largest of th~ screens. On the other 
hand, if no screen matches the type specified by the screen number-for 
example, if you specify •2,• but do not have a color screen-then Malcolm 
will display the client on the main screen, that is, the one displaying the menu 
bar. 

This section introduces you to the functions available in the Malcolm menus. 
Besides supplying all the tools found in standard X products, Malcolm 
enhances many of them by extending their capabilities or making them 
simpler to use. 

Remote commands 

Since Malcolm operates under the Macintosh operating system, instead of 
theUNIX or VMSna operating systems, X applications cannot run directly on 
the Macintosh. In order to display clients on your screen, you must issue a 
remote command to a host on which the clients you want to use reside. 
Figure 1-7 shows the Remote Command window in which you type your 
command, usemame, password, and other options. Selecting New Command 
from the Remote menu, shown in the margin, brings up the Remote 
Command window. 
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• Fjgure 1·7 The Remote Command window 

[t.111 Rl'lllUll' (Ulllllldfltl 

Remote Command: i Ula: I ....----------..... ; /usr/bln/H11/Hterm -Is -n 
1
, Host: I 

llhost -dlsplay 8dtsplay:o.o · 

MacffPI 

pluto 

Zone: 

181 EHecute et Startup ,I usemome::::;;la~d~•~;:::==: 
,__c_o_m_m_an_d_N_e_m_e_: ___ ....., Password: I 
I I !.·, ~-~===-----' pluto Hterm . 
...._ ________ _.... 1 181 Saue Password 

Output: I Notify I 1-.~-
Seued Lines: I 1 oo ! ! ( Accept ) ( Delete ) 

After entering a remote command, you have the option to execute, accept, 
cancel, or discard it. Executing or accepting the command enters it in the Edit 
Command and Execute Command submenus. These submenus are dimmed if 
no commands exist The Command Output submenu, if not dimmed, 
displays a list of commands that are currently executing or have command 
output. Choosing a command in the list displays an output window that 
shows any information generated by or about the command. For basic 
information about remote commands and step-by-step instructions for 
displaying a terminal emulator, like xterm, on your screen, read Chapter 2, 
"Getting Started.• For advanced information about remote commands, read 
Chapter 3, "Using Remote Commands." 

Window management 

Use the Window menu, shown in the margin, to shrink client windows to 
icons, choose a different style for ·a client window from the five shown in 
Figure 1-8, and move or resize a window that doesn't have a title bar or size 
box. To learn more about these features, read "The Basics of Using 
Windows• in Chapter 4. 
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• Flpte 1-8 Malcolm Window styles 

C~ing Iconify from the Window menu lets you shrink a client window 
into a icon in order to move it out of the way. lconifying does net kill a 
client or suspend what its doing. Double-clicking on the icon returns it to 
normal size. 

Temporarily Adorn allows you to move and resize a window that does not 
have a title bar or a size box by temporarily converting the window to the 
style that has these elements (the second window from the left in Figure 1 • 
8). You have one opportunity to either move or resize the window, after 
which it reverts to its former style. 

The command, Oose Window, changes depending on the type of window 
that is in the foreground (what we call "active• in the Macintosh world). 
Clnse Window closes a Malcolm window, such as the Remote Command 
window or the Color Namer window if it frontmost. If a client window is 
frontmost, the legend changes to Kill Oient This command causes an abrupt 
discoMection. Before killing a client read •1..ogging Off Versus Killing Clients• 
in Otapter 2. To close all client windows and exit from Malcolm, select Quit 
from the edit menu. Again, Chapter 2 contains a complete explanation of this 
procedure. 
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Cut, copy, paste, and other editing features 

Malcolm enables you to cut, copy, and paste text between a Macintosh 
application or desk accessory and a Malcolm dialog window that contains 
text, such as the Remote Command dialog window. As in any other 
Macintosh application, these functions are located in the Edit menu, pictured 
at left, and perfonn the same way. Because clients have their own 
commands for cutting, copying, and pasting, you cannot use Macintosh 
commands (Command-X, Command-C, Command-V) in a client window. 
However, Malcolm does track when a client cuts or copies text and records 
the selection in the Clipboard. Once something is in the Clipboard, you can 
paste it into any Macintosh fde or document, such as a MacWrite document, 
for example. To paste text from a Macintosh file to a client window you 
must use the client's command for pasting or inserting (not Command-V). 
Malcolm transfers the contents of the Clipboard to a cut/paste buffer, the 
equivalent of a Clipboard in the X world, and then to the point selected in the 
client document. 

The Edit menu also contains Undo and Oear, which both perform their 
normal Macintosh function, as well. Undo undoes the last change, but only 
functions with desk accessories. Malcolm does not support it. Clear erases a 
selected item without saving it to the Clipboard. 

Preferences 

The Preferences submenu, also located in the Edit menu, allows you to select 
default settings for the items shown in the left margin. Selecting either of 
the first two items, displays a Rooted Screen Setup window, which allows 
you to set the size of the root window and specify a display option. 

Normally, most people need not alter the default root window preferences. 
Unless you are an experienced user of X, you would be better off not 
experimenting with them. However, those who need more information 
should read "Root Window Preferences" in Chapter 4. 

Windows, the next item in the Preferences submenu, permits you to choose 
a default window style for client windows from the ones shown in Figure 1-
8. The next time you start a client, it's window should appear in that style, 
unless the client specifies its own preference. The window styles in Figure 1-
8 apply only to client windows in rootless mode, in the areas outside the 
boundaries of a visible root window. 
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Figure 1-9 depicts the last entry in the Preferences submenu, Miscellaneous, 
which contains five options. Oicking the first checkbox saves passwords 
entered in Remote Command windows so tha~ you don't have to retype 
your password every time you execute a remote command. The passwords 
are saved in the settings document and are encrypted to provide an extra 
measure of security adequate for most business needs. In cases where 
passwords aren't saved in remote commands, dicking the second checkbox 
will cause MacX to prompt you for these passwords when you execute such 
commands. 

The next two options for smoother animation and fast arc drawing should 
usually be left checked. See Appendix A for an explanation of these options. 
The last option enables you to ch~ whether to use the Option key to 
make the Arrow keys scroll or act as extra mouse buttons. See the section 
called "Mouse Differences• in Chapter 2 for an explanation. 

• Figure 1-9 The Miscellaneous Preferences 

"11 ... 1 Pll<1111•nu., P1PrP1P1H ""' 

r&I Seue Passwords In Settings Document 

r&I Prompt fer Passwords if Empty 

r&I Smoother (but Slightly Slower) ftnimation 

r&I Use Fast (but Nonstandard) ftrc Dnwlng 

----··---------
Rrrow Keys Yield: 

QRrrows 

I OK I 
(Cancel ) 

®"Mouse Buttons," Control, and Mete 

Without Option Key With Option Key 
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Fonts 

Choosing Fonts from the Edit menu brings up the Font Director window 
pictured in Figure 1-10. This window displays a list of all the fonts available 
for use with clients. These can be either X Fonts or Macintosh fonts, which 
are distinguished by a little icon at the beginning of the font name. Since 
font names tend to be long and unwieldy, the Font Director allows you to 
include aliases that are shorter and easier to remember as substitutes for font 
names. Aliases also have a distinguishing icon. 

• Figure 1-10 The Font Director Window 

[) MdtH Fonh 

-Bitstrum-oi.-t ... -Bold-t-Nonn~l--1 0-1 00-75-75-P-62-ISOB859-1 
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-Bttstrnm-0.¥t.,.-Bold-t-Nonn•1--15-140-75-7l5-P-9!-ISOB859-1 

8-ettstrum-oi.-t.,.-Bold-l-Nonn•l--19-180-75-75-P-t 17-1508859-1 

1-··-···-.. ·--·--···-···--·--···-···-···--·--···-···--·--·--···-···--·--···-···-···--·--···-···---................................. --·--·--···-···--·--···1 

!The quick brown fox jumped ov~ 
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The Font Director also allows you to son fonts in a variety of ways. In 
Figure 1-11, the ficld labeled "Sort Bt is actually a pop-up menu containing a 
long list of sorting methods. Simply select an item from the list and the Font 
Director will resort the fonts accordingly. The Font Director will also compile 
fonts from Adobe Bitmap Distribution Files (BDF) when you click the New 
Font button. For more information about the Font Director and compiling 
BDF fdes, read Chapter 5, •Managing Fonts and Color.• 

Color Namer 

The last item in the Edit menu, C.olor Namer, displays the Color Namer 
window, when selected. This window, depicted in Figure 1-11, displays a 
sample of all the colors available for use with clients that support color. Each 
color has a name that you can modify or copy to a command in a client 
window. You can also create new colors and remove existing colors. When 
you do, the Color Namer automatically resorts the colors, by name, so they 
remain in order. See Oiapter 5 for more information about using the Color 
Namer. 

• Figure 1-11 The Color Namer Window 
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Save, Kill, Quit, and other File menu commands 

Like the Edit menu, the File menu contains a number of options that 
function in the normal Macintosh way. The New command creates a new 
settings document in which you can create and save new commands and 
preference settings. Open allows you to open an existing settings document, 
provided that one is not currently open. The Close command closes the 
settings document currently open. If the file i.s new, the name "Untitled 
Settings• appears. Click Save to save your settings or Save As to save your 
settings and name the file. However, should you forget and select Close 
"Untitled Settings,• a standard Macintosh dialog box inquiring "Do you want 
to save your changes?• appears anyway. Read Chapter 2 for more information 
about the settings document. 

\ 
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Getting Started 

BEFORE READING 11-0S CHAPTER, BE SURE TO INSTAll YOUR COMML'NICATI0'5 

software and Malcolm. Chapter 7 covers installation procedures. Once 

Malcolm is up and running, you'll be ready to read this chapter and learn the 

basics about Malcolm. 

This chapter covers the minimum you need to know to function in an X 

environment using a Macintosh. You'll learn how to open Malcolm, log on to 

a host and start a terminal emulator on your screen, log off the host, and, 

finally, close Malcolm. Once you feel comfortable with these fundamentals, 

you can consult the remaining chapters to customize your X environment 

and learn more advanced features. However, please note that some areas, 

such as handling fonts, require technical expertise. Consequently, to avoid 

problems, consult your resident X expert if you are not technically oriented 

and are not sure what to do. 
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Opening Malcolm 
To open Malcolm, double-dick the Malcolm icon, shown at left, or click the 
iron once and choose Open from the File menu. Your desktop should look 
similar to the one shown in Figure 2-1. You should see the four Malcolm 
menu headings in the menu bar at the top of your screen and, if Multifmder 
is active, the Malcolm icon at the far right. If you have not already done so, 
read Chapter 1, •Malcolm Overview: for an explanation of the menus and an 
overview of Malcolm. 

• Figure 2· l Malcolm Desktop 

Although you don't see it, Malcolm always opens a new settings document 
when it starts up. This document stores your whole environment and 
everything you do in it, that ~.every remote command you create, every 
preference and window style you choose, and so forth. When you quit, 
Malcolm will prompt you to name and save your settings document. If you 
don't, Malcolm will discard everything you've set up. If you do, Malcolm will 
create a document icon labeled with the name you have entered. Later, you 
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can click the icon and return to that environment exactly as you left it. This 
feature enables you to customize environments for different hosts, clients, 
types of tasks, or working styles. For example, you could create an 
environment for doing budgets-in which a spreadsheet client automatically 
opens in the middle of your screen and a calculator appears in the upper right 
comer-and save it in a settin~ document called •budget.• 

If you want to exit from Malcolm and you haven't made any changes that 
you want to save, such as creating a remote command, simply select Quit 
from the File menu or press Command-Q and Malcolm will close. If you have 
made changes, the dialog box •save changes before closing?• will appear. See 
the section called "Quitting Malcolm• at the end of this chapter for further 
instructions, if you need them. 

Before proceeding further, you should know about the differences between 
the Macintosh mouse and keyboard and the standard mouse and keyboard 
specified for Xll. 

Mouse differences 

Because the Macintosh uses a one-button rather than a three-button mouse, 
you cannot issue commands with the mouse like you normally would in 
other X environments. As an alternative for the missing two buttons, use 
the arrow keys instead, as shown in the chart in Figure 2-2: 

• Figure 2-2 

Mouse button 
Left arrow 

Right arrow 

Up arrow 

Down arrow 

Substitute mouse buttons 

Malcolm Function 

Left mouse bunon 
Middle mouse button 

Right mouse button 

Meta modifier (modl) 

Control key 

To use the arrow keys for their nonnal purpose, hold down the Option key before 
pressing one of them 
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If you would rather reverse this procedure-that is, pr~ the Option key 
together with an arrow key to get extra mouse buttons-you can select the 
Arrows button in the Miscellaneous Preferences window, as shown in Figure 
2-3. 

• Figure 2·3 The Arrow keys preference option 
--·--.. -------·-----·---

Arrow Keys Yield: 
ORrrows 

®"Mouse Buttons," Control, end Meta 

Without Option Key With Option Key 

Arrow Keys Yleld: 
®Arrows 

O "Mouse Buttons," Control, end Mete 

Without Option Key With Option Key 

To find Miscellaneous Preferences, select the Preferences submenu from the 
Edit menu and slidedown to Miscellaneous. 

Keyboard differences 

The Macintosh Plus keyboard has no Control key, so you must use the 
Command key (IC) instead. As a result, you can no longer use the Command 
key to select menu items from the keyboard, such as M-X to cut and IC-V 
to paste, while Malcolm is running. 
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Malcolm has a variety of dialog windows, dialog boxes, and alert boxes that it 
will display when you select a certain option or need to respond to an event. 
See Figure 2-4 for an example. These boxes contain a collection of fields, 
buttons, or both, which you must select or click. Sometimes pressing keys 
on the keyboard is more convenient than using the mouse to click a button 
or select a field. For such instances, here is a list of substitute keys and the 
action each perfonns: 

• Table 2·1 Keyboard sub.stitutes for clicking bunons 

Key(s) Action When to use 

Y,O, 1 yes or OK Use to select an outlined bunon in a dialog or alert box 
that has no text fields. If the box has text fields, the 
number or letter is interpreted as text rather than as a 
command and is entered into the field that has the 
cursor in it. 

CR, Enter yes or OK The carriage return or Enter key. Use to specify yes or 
OK in any dialog window, dialog box, or alert box, 
including those with text fields. 

N,C,O no or Cancel Use to specify no or cancel in a dialog or alert box that 
has no text fields. If the box has text fields, the number 
or letter is interpreted as text rather than as a command 
and is entered into the field that has the cursor in it. 

H. no or Cancel Command-Period. Use to specify no or cancel in any 
dialog window, dialog box, or alert box, including 
those wirh text fields. 

Esc Cancel Escape key. Use to select the cancel button in any 
dialog window, dialog box, or alert box, including 
those with text fields. 
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Key(s) 

Tab 

Arrows 

Action 

Tabbing 

Scrolling 

'l'hen to use 

Tab key. Use to tab to the next text field. 

The Up, Down, Left, and Right arrow keys. Use to move 
the cursor and to scroll vertically and horizontally in 
lext fields. Fields can contain a maximum of 255 
characters. The arrow keys will also move the cursor to 
a different insertion point. 

+ Using letters and numbers to scroll: The Color Namer and the Font 
Director, two features described in Chapter 5, won't interpret letters or 
numbers as yes, no, OK, or cancel actions. Instead, they interpret any 
letters or numbers typed as scrolling instructions. See Chapter 5 for more 
information. 

Starting a Terminal Emulator 

Once you've opened Malcolm, you'll notice that your desktop doesn't look 
any different except for the different menu headings in the menu bar at the 
top of your screen. Since the presumption, in this section, is that you'll be 
creating a brand new X environment, be sure to click the Malcolm application 
icon and not a Malcolm document icon, pictured at left. If you click a 
Malcolm document icon, someone will have already entered commands and 
set preferences that may have slightly or totally altered the initial look of the 
desktop described here. For example, the root window may be visible or 
some clients, like xclock, may suddenly appear. This section will not describe 
these nuances. Instead, it will show you a basic way to establish a 
connection with a remote host computer so that you can run clients and 
operate as you normally would. 

Aft.er opening Malcolm, the next step is to create a remote command that 
logs on to a host, starts up a terminal emulator, and displays a window on 
your screen. You'll need to run a terminal emulator so that your Macintosh 
resembles a type of terminal recognized by your host. This section will cover 
an example of this pi'occdure for a host running A/UX or UltrixTM (two 
versions of the UNIX operating system). 
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Xterm is a tenninal emulator that operates under UNIX. It enables your 
Macintosh to communicate with another Macintosh running A/UX, Apple 
Computer's implementation of UNIX System V developed by AT&T, and 
with a VAX running Ultrix, Digital Equipment Corporation's implementation 
of 4.2 BSD UNIX. To start up xterm, follow these steps: 

1. Select New Command from the Remote menu or press Command-R. 

The Remote Command window, illustrated in Figure 2-4, will appear. 

• F.lgutt 2-4 The Remote Co!llllland window 

El.lit Remote Commdnd 

.--R_e_m_o_t_e_c_o_m_m_e_n_d_: -----. j Uia: MacTCPI 

/usr/bin/H11 /Hterm -Is -n l Host: pluto 
®host -display 8display:o.o 

l Zone: 
i ,__ _________ __. i 

C8I EHecute at Startup l 
i 

command Name: i I 

usememe:_l e_d_e ___ _ 

Password: I ... I p-lu_t_o_H_t-er_m _____ __,I I 
----------- • 181 Snue Password 

Output: I Notify I ! ······-... ·······-... ·····································-·· 
Seued Lines: I 100 1. ( EHecute J ( Cancel ) 

i ( Accept ) ( Delete ) 

2 Enter the remote command to start xtenn. 

Type the command shown in the Remote Command field in Figure 2-4 
and press the Tab key. Do not type carriage returns. Your UNIX 
documentation should explain xterm and all its options; however, some 
of the options are Malcolm enhancements which require explaining here. 

-n ®host This option includes the host name in the title bar of 
the xterm window that will appear on your screen. The 
option, ®host, is a placeholder for the name of the host 
you want to contact. You can enter the actual host 
name if you want to. 
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-display ®display:O.O 
The ®display option is a placeholder for the display 
station name or network address used by the host to 
identify your Macintosh. Alternatively, you can enter 
the actual name or address. 

In the :0.0 extension, the first O represents the display 
station number and the second 0 represents the screen 
number. The display station number for a Macintosh is 
always zero because Malcolm can support only one 
display station. The screen number represents a mode 
(rooted or rootless) and and a type of screen (color or 
monochrome). In this case, the number zero (0) specifies 
a monochrome screen in which the root window does 
not appear (rootless). Malcolm will display the xterm 
window on the largest screen that fits these 
parameters. For further instructions on specifying 
screen numbers see Table 1-1 in Chapter 1. 

3. Complete this xterm command by following the instructions for 
each field and check box listed below. 

Execute at startup Click this box so that the xterm window will 
appear as soon as you open your Malcolm settings document. 

Command name: Malcolm automatically enters an abbreviated name 
for your command here. This name appears in the Edit, Execute, or 
Command Output submenus so that you can select it later when you 
want to edit it, execute it or view its output. If you don't like the name 
Malcolm has devised, enter another one. 

Output: Select Save or Notify from this pop-up menu to retain any 
system or error messages generated in case the command doesn't work 
or gets interrupted by a problem with the host or the network. The 
Notify option triggers a beep and a small, flashing Malcolm icon to appear 
at the right end of the menu bar when Malcolm receives output from the 
host See Chapter 3 for an explanation of the other output options. 

Saved lines: Specify in this field how many lines of command output 
you want to save. The maximum number is 5,000 lines. The number 100 is 
probably sufficient because the xterm command will normally produce 
little or no output. 
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Via: Via is another pop-up menu that displays a list of communications 
protocols, called connection tools, that enable you to contact hosts on 
which clients (X-based application programs) reside. Select the one used 
by the host that will receive this command. In Figure 2-4, MacTCP™, 
Apple's implementation of TCP/IP communications protocol for the 
Macintosh, is the connection method chosen. If you don't know which 
connection method to select, contact the system administrator who 
maintains the host you want to log on to. 

Host: This pop-up menu displays the names of the hosts that use the 
connection method selected in the Via menu. Select the appropriate host 
name or, if it is not in the list, choose Other from the menu. When the 
dialog box shown in Figure 2-5 appears, type a host name. · 

• Figure 2-5 The host name dialog box 

Please enter the new Host: 

lplutq 

DK · ( Cancel 

Zone: This field is for information purposes only. It indicates your 
AppleTalk network zone or your MacTCP network domain, depending on 
which connection method selected in the Via menu. If you selected 
neither of these tools, the Zone field will not appear. 

User name: This field contains the user name recorded in the Chooser 
(located in the S menu). Change it to the user name assigned to you on 
the host receiving this command. 

Password: Enter your password for the host receiving this command. 
Each character typed appears as a dimmed, gray box for security purposes. 

Save password This check box should be dimmed. If not, leave it 
unchecked for now. For more information, see Chapter 3 
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4. Click the Execute button or press the carriage return to execute 
your mmmand. 

After a brief pause, an xterm window similar to the one in Figure 2-6 
should appear on your screen. 

• Figure 2-6 Sample xterm window 

plutoC1l> I 

If nothing appears after a minute or so, you may have made an error 
typing the command, your username, or your password. See the next 
section, "Handling Errors,• for advice. 

For other types of problems, such as network malfunctions, alert boxes 
will appear on your screen stating the type of error. See Chapter 6, 
"Troubleshooting,• if you need more help. 

You have now successfully transmitted your first remote command to a 
host computer using Malcolm. The xterm window displays a system prompt 
at which you can enter commands just like you would on any terminal 
logged in to this host. At this point, you can enter commands to start up 
other clients stored on the host. You'll find starting up clients this way 
much faster and easier than issuing remote commands. 
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Notice that the xterm window has a title bar like a Macintosh window, 
which allows you to move it around. If you want to learn more about 
manipulating windows in Malcolm, read "The basics of using windows" in 
Cllapter 4. 

When you are ready to exit from Malcolm, read "Quitting Malcolm" at the 
end of this chapter. 

If you want to learn more about issuing remote commands, read Chapter 3. 

Under certain circumstances an error can occur without Malcolm notifying 
you d it. This situation can happen if you make a mistake typing a remote 
command, your usemame, or your password and you have selected the Save 
or Notify command output option. The Save option saves any information 
from the host about your command in the command's output window, but 
does not notify you of this occurance. The Notify option is a bit friendlier 
because it makes your Macintosh beep and display a small, blinking Malcolm 
icon in the menu bar when Malcolm receives command output. In both 
cases, the intent is to spare you from having to deal immediately with every 
bit of information generated by the host, regardless of its pertinence to 
what you are doing. When something goes wrong, however, you have to 
bring up the output window yourself to discover what system or error 
messages the host transmitted. 

No xterm window opens 

After issuing the xterm command, if you do not see the xterm window 
within a couple of minutes, an error most likely occurred. To verify this 
condition, select Command Output from the Remote menu and slide the 
mouse to the right until you see the short name for your command. Select 
this name in order to display the output window. You'll see a window, like 
the one in Figure 2-7. 
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• fJpre 2· 7 Sample output window 

pluto Hlerm Output 
Host: pluto 

(EHlted) Delete output 

'tl 10842 
~lbln/Xlt/xt-: bad CGMlal'ld I ine option ·-· 

utfG99: ~/bin/XI 1/xtera 1-helpl 1-displo,i dlspl..,_I l""91101tl 

t•/+rYI l-tlg color! l-fg c:olorl 1-bd colorJ 1-M rulbrl f-,fn f 

I-iconic I 1- string! I-ti tie string! l""Xrtl NIJOlrCUtringl :~._' .• ::,!,','.; 

1-/+ahl I-ti rulberl 1-/+cbl I-cc: classrangel 1-/+cnl I-er color _ 

l-fb font,_. I 1-/+j l 1-1+1 I t-lf fi •-l l•/+lsl 1-1 ... bl .Ill 
1-.c •i 11 incondsl~-- c:olorl l•nb nullberl l"-/-1 l•/+sl I•/ ~Iii 
1-/+si I 1-/+skl 1-sl ni.aberl 1-/+tl 1-UI string I 1-tn ncn•I l-/ 

This window contains an error message indicating that a hyphen was used 
incorrectly in the remote command string. Once you determine what your 
error is, select Edit Command from the Remote menu and bring up the 
Remote Command window for your command. Correct the problem and 
execute the command again to see if it works. 

Other problems 

For other types of problems, such as a misspelled host name or a network 
malfunction, alert boxes describing the error will appear on your screen. Most 
of these problems should be easy to foe. However, if you need more help, see 
Chapter 6, "Troubleshooting." 

Quitting Malcolm 

When you want to exit from Malcolm, be sure to exit gracefully from any 
clients that contain information you want to save. Specifically, make sure to 
log off the host session running in your terminal emulator (xterm or 
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equivalent). Next, choose Quit from the File menu or press Command-Q. The 
•Save changes before closing?" dialog box, depicted in Figure 2-8, will appear. 

• Figure 2-8 "The Save changes before closing?" dialog box 

~ Saue changes before closing? 

l Yes J 
( No J Cancel 

To save the remote command you created earlier in this chapter and any 
other changes, such as window styles, click the Yes button. You will next see 
the •save as" dialog box depicted in Figure 2-9. As discussed at the beginning 
of this chapter, Malcolm has created a settings document to preserve 
everything you have set up, that is, your entire X environment. Unless you 
save the settings document, Malcolm will discard everything. The document 
is currently labeled "Untitled Settings.• Enter another name in the 
highlighted field and either press the Return key or click the Save button. 
Malcolm will create a document icon labeled with the name you have entered. 
Later, you can click the icon and return to the same environment you just 
created. 

• Figure Z-9 The "Save as" dialog box 

.le MacH 1.0d&l 

CJ MacTCP I .Ob7 
D Relea\t~N<tt<~\ 
D Rel<•a\t~N(J t <~\ 2 
D S1sm1>le 

I Malden Uoyage 

A G::::>chez Metz :!::!: 

EjPC1 

Drtue 

Saue 

Cancel 
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You may be tempted to close your terminal emulator window by clicking 
the cluse box or by choosing Kill Oient from the File menu. However, Kill 
Client is not the preferred way to duse an xterm or other terminal emulator 
window because it effects an abrupt disconnection, like disconnecting the 
telephone. Any unsaved data you had entered in a ftle would probably be lost 
unless the bust had some way of retaining it Kill Client is designed to 
disconnect clients, like xclock, that provide you with no way to issue 
commands to them directly. It is also useful to programmers who want to 
stop a runaway program. 

Fortunately, Malcolm does not immediately execute a Kill Client request. A 
dialog box appears first inquiring whether you really want to kill the client 
(see Figure 2-10). 

• Figure 2-10 The Kill Client dialog box 

Are you sure you want to kill 
the client that created the 
frontmost window? 

( OK J (cancel] 

To leave the environment in which you are currently working without 
quitting Malcolm, choose Close "Untitled Settings" from the File menu. Both 
the "Save changes" and the "Save as" dialog boxes will appear as described 
above. Follow the same procedure to save and rename your untitled settings 
document. Malcolm will create a document icon labeled with the name you 
have entered, just as it does when you specify Quit. The difference is the 
Malcolm application will still be open. The Malcolm menus will still be there; 
however, you will only be able to create a new settings document or quit 
Malcolm, unless you reopen an existing Malcolm settings document. 
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Using Remote Commands 

c HAPTER 2 !ITTRODUCED llEMOTE COMMANDS BY DES<mBING HOW TO ACllVATE 

a terminal emulator, such as the xterm terminal emulator used with the 

UNIX operating system. This chapter covers remote commands in depth. It 

describes all of the command options available as well as how to create new 

commands, edit and execute commands, and view command output. 

Since Malcolm creates a settings document each time you invoke it, your 

entire environment, anything you do-from creating commands to setting 

window preferences-is stored in that document until you close it. At that 

point, be sure to save the settings document unless you want to lose 

everything you've been working on. Malcolm will prompt you for a name, if 

the document is new, or else ask you if you want to save your changes. 
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The Remote menu 
Malcolm enables you to issue commands to a remote host using the Remote 
menu illustrated in Figure 3-1. This menu is always located in the menu bar at 
the top of the screen. 

• Figure 3-1 The Remote menu 

Window 
New Command... •R 
Edl1 Command • 
E1iec uh~ c r>mmood • 

Commol\d output • 

Choosing New Command from the menu causes a dialog box to appear in 
which you can type a new command and execute or save it, if desired. Edit 
and Execute C.Ommand are submenus containing a list of existing commands. 

r--"\ 
~· 

Choosing a command from the list enables you to edit or execute an existing ,/ 
command. Selecting the Command Output submenu displays a list of 
commands that are currently executing. To see the output and status of a 
particular command, select its name from the list. For more information on 
using these submenus, read "Viewing, editing, and executing commands" at 
the end of this chapter. 

+ Use remote commands sparingly: Remote commands are a very time­
consuming and memory-intensive way of starting up clients. For quicker 
results, start up a terminal emulator and issue commands through it to 
launch clients. 

Creating new commands 
To create a new command select New C.Ommand from the Remote menu. 
The Remote C.Ommand window, illustrated in Figure 3-2 will appear. 
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down the option key and press r. 
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• Figure 3-2 The Remote Conunand window 

Remote Commend: ! Ula: 
I MecTCPI 

/usr/bin/HI 1/lco -geometry I I Host: pluto 
SOOHSOO -display 
8dlspley:O.O ! Zone: 

; 

I 
O EHecute et Startup 

Commend Name: Password: I 
lpluto lco 11 ~ Seue Password 

I ---Output: I Saue 

i IEHecute J ( Cancel ) 
Saued Lines: I • 00 I ( Accept ) ( Delete ) I 

This box contains a number of text fields and pop-up menus. All the fields 
scroll up and down and from left to right. To scroll through them, use the 
mouse or the arrow keys. 

The following paragraphs explain the use of each field and menu item. 

• Remote Command 

This field scrolls so that you can enter a lengthy command or more than 
one command, if desired. Type the command the way you nonnally 
would, using the syntax required by the host for which the command is 
destined, or substitute the following macros for the relevant command 
options, when applicable. By enabling you to avoid specifying a particular 
type of host or display, these macros make the commands that use them 
more generic. Be sure to include the registered mark, ®,when using these 
macros so that the Malcolm server can distinguish the macro name from 
regular text. 

®display Replaced with _the display name or network address used 
by the host to identify your Macintosh. For instance, if 
your network uses TCP/IP protocol, ®display would 
replace the IP address assigned to your Macintosh, 
90.1.3.13, for example. 

®host Replaced with the host name specified in the host field of 
the Remote Command dialog window. Among other 
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thin~, this macro is useful for displaying the host name 
in the tide bar of a dient window so that you remember 
what host that client is running on. 

• Execute at Stattllp 

Check this lx>x if you want your command to begin executing when you 
open the settings document it is saved in, either by double-dicking the 
document icon or by choosing Open from the File menu. This option will 
take effect the next time you open the document. To temporarily bypass 
this option later, hold down the Option key while opening the settings 
document. 

• C.Ommand Name 

Assign a command name for the command you've entered so that you 
can select it later from the Edit Command or Command Output 
submenus. Malcolm automatically places a name here composed of the 
host name and either the first word in the command string or, if it's too 
long, the last part of the first word.(A Ian: what df d you 
decfde to do here?) Malcolm defines a word as a collection of 
alpha-numeric characters separated by blank spaces. The characters 
indude A through Z, 0 through 9, underscore ( _ ), dash ( - ), period ( . ), 
and dollar sign ( $ ). Accordingly, in the sample command shown in Figure 
3-2, Malcolm indentifies /usr/bin/Xll/ico as the first word. It combines 
the last part, •ico,• with the host name •pJuto" to produce the short 
name "pluto ico. • (Note that the slash ( I ) does not belong to set of 
alphanumeric characters defining a word.) If you don't like the name 
Malcolm has devised, change it to something else. 

• Output 
This pop-up menu, depicted in the margin, allows you to select four ways 
to be notified of output from your command once it executes. Malcolm 
will put this output in the command's Output window as it arrives. 

Notify This selection causes a beep and displays a small, blinking . 

Chapter 3: Using Remote Commands 

Malcolm icon at the right end of the menu bar. To cancel the 
notification and see the command output, select the com­
mand name from the Command Output menu. A Macintosh 
window displaying the output will appear, as shown in 
Figure 3-3. Simply click the close box to close the window. 
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Pop up 

Save 

Discard 

Selecting Pop up causes the Output window to auto­
matically appear on the screen. If you are using Multifinder, 
Malcolm must be in the foreground for the window to pop 
up. 

If you want to save command output, but not be notified, 
select this option. When you want to see the output, select 
the command's short name from the Active menu. 

Selec.t Discard if you don't want to be notified of or save 
command output. This option is useful when the output is 
a process id number or some similar system information 
that does not interest you. 

• Figure 3-3 The Output window 

pluto ico Output ------- EJ;;; 
Host: pluto 

<Running> ( Change Settings ... ) 

I 

• Saved lines: 

Enter the number of lines of command output you want to save here. Up 
to 5,000 lines can be saved. 
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See "Saving Pa~words" in this 
chapter for instructions on setting this 
preference. 

• Via: 

Via is another pop-up menu that displays all the communications 
protocols, or connection tools, installed by means of the Macintosh 
Communications Toolbox. Select the connection tool used by the host 
that will receive your command. In Figure 3-2, the connection method 
chosen is MacTCP, Apple's implementation of TCP/IP communications 
protocol for the Macintosh. 

• Host: 

This pop-up menu, also shown in the margin, displays the host names 
presentJy associated with the connection tool selected in the Via menu. 
To add a new host name, choose Other from the menu. 

• zone: 
Zone lists the network wnes in AppleTalk® or the network domains in 
TCP/IP. This field does not appear if the connection method in use does 
not support zones or domains. The Via field shows what connection 
method is currently selected. 

• Username: 

This field automatically shows the user name recorded in the Chooser. 
Change it to the ID assigned to you on the host receiving your command. 

• Password: 
Save password 

Enter the password assigned to you on the host that will receive your 
command. F.ach character typed appears as a dimmed, gray box for 
security purposes. If you have chose "Save Passwords .. ." in the 
Preferences submenu, the "Save Passwordn check box in the Remote 
Command window will be activated. Click this box if you want to save 
your password for this command in the settings document. When you 
execute the command, Malcolm will automatically send the password to 
the host. Malcolm encrypts all passwords in the settings document, thus 
ensuring a reasonable measure of security for most business purposes. 

If you don't click this box, the Password field will always be empty and 
you will have to enter your password every time you execute the 
command. In the latter case, the Remote Command dialog window will 
appear so that you can type your password in the Password field. 
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• AcUon Buttons 

Clicking any of these buttons performs the desired operation and closes 
the Remote Command window. 

Execute 

Accept 

Cancel 

Delete 

Executes the command and automatically saves it 

Saves the command without executing it 

Erases a new command and the current revisions of an 
existing command 

Erases the command 

Saving passwords 

If you would rather not type your passwords every time you issue a remote 
command, you can have Malcolm save them in the settings document. To 
save passwords, choose Miscellaneous from the Edit menu. Figure 3-4 shows 
the Preferences submenu. 

• Figure 3-4 Selecting Miscellaneous Preferences 

acz 
1----··--.. ·--·----.. ·-.. 

Cut XH 
Copy ace 
Paste XU 
Clear 

Monochrome Rooted Screen ••. 
Fonts... XF Color Rooted Screen ••• 
Color Namer... Windows ••• 
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When the Miscellaneous Preferences window appears, click the Save ;~, 
Passwords checkbox and click OK. M a result, the corresponding Save 
Password checkbox in every Remote Command window will be highlighted 
so that you can check it, if desired. 

• Figure 3-5 Miscellaneous Preferences window 

!o-11'1 l'lld111•1111' Pr PIPl l'lll t"\ 

181 Seue Passwords In Settings Document 

181 Prompt for Passwords If £mpty 

181 Smoother (but Slightly Slower) Animation 

181 Use fest (but Nonstendord) Rrc Drewing 

Rrrow Keys Yield: 
ORrrows 

I OK I 
(Cancel J 

®"Mouse Buttons," Control, end Mete 

Without Option Key With Option Key 

Malcolm encrypts all password in the settings document, providing a level of 
security sufficient for the needs of most businesses. Taking additional 
precautions to protect secret or sensitive information, however, is a wise 
practice. 

Unless you do not need passwords for one or more of the hosts you log in 
to, you should also click the second check box, •Prompt for Passwords If 
Empty.• This option ensures that Malcolm will prompt you for a password 
if you execute a remote command that has a blank password field. Selecting 
this option is especially important if you do not save passwords in your 
remote commands because it will circumvent log-in failures. 
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Viewing, editing, and executing commands 

The Remote menu has three submenus that enable you to edit and execute 
existing commands and view the output of commands currently being 
executed. Figure 3-6 shows an example of the Edit Command submenu. Each 
item listed is the name of a command When you select one of the items, the 
dialog window for that command appears and you can edit, delete, or 
execute it. 

• Ffgure 3-6 An example of the Edit Command submenu 

pluto ico 
EHecute Command ~ pluto Hclock 

.. -........... -........... _ .. _ .......... _ .. _ ........... -.............. pluto Hterm 
[ !)tntlltHH1 Output • 

The format of the Execute Command and the Command Output submenus 
is the same. However, when you select a command from the Execute 
Command submenu, the Remote Command window does not appear. 

Selecting an item from the Command Output menu displays the Output 
window for that command, like the one in Figure 3·3. For more information 
about the Output window read the following section. 

As explained earlier in this chapter, the Output window displays information 
generated by a command (or about a command) while the command is 
executing. To get the Output window, select the command's short name 
from the Command Output submenu. The window appears, regardless of 
the method chosen to handle output (see the option displayed in the output 
field of the Remote Command dialog window). If you have selected the 
Discard option, however, the window will be empty. To make the Output 
window pop up automatically when a command starts executing, select the 
Pop up option. The window will pop up as long as Malcolm is in the 
foreground. 
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Figure 3-7 illustrates the top portion of the Output window. The name of 
the h~t on which the command is running appears on the left, in this case 
"pluto. • A word indicating the status of the command appears in the middle, 
in parentheses: either •running" or •exited.• 

• Flpte 3-1 Top portion of the Output window 

pluto lco Output !.II 

Host: pluto 
<Flllmino> ( Cbenge Settings ... ) ~ 

Clicking the button on the right enables you to change the output status of 
your command. A dialog box appears, as shown in Figure 3-8. 

• Fipte 3-8 The Change Settings box 

( DK 

( Cancel ) 
Seue 11100 

Output: Pop up I 

The output field in this box pops up like the one in the Remote Command 
window so that you can easily make a selection. You can also change the 
number of command output lines you want saved in the Save Lines field. 
Remember that the Output window will contain no more than the number 
of lines you specify here. Malcolm will discard any additional output by 
erasing from the beginning so that the m~t recent command output is 
retained. 

Clicking either of the two buttons on the right will cl~e the Change Settings 
box. Click OK to save your changes and close. Click c.ancel to close the box 
without saving any changes. 
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Handling Windows 

c IW'J'ER I COVERED THE ESSENTIALS ABOUT WINDOWS, INCLUDING HOW IBEY 

function in rooted and rootless mode. This chapter describes how to handle 

windows in more detail. Also covered are instructions for setting root 

window and window style preferences. 
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The Window menu 

Styling and manipulating 
windows 

The basics of using windows 

One advantage to running X applications on a Macintosh is that they can run 
in windows that look and act like Macintosh windows. So, if you're familiar 
with the Macintosh, you already know a lot about handling windows in 
Malcolm. In addition to these familiar features, though, Malcolm offers 
other handy features as well, including a selection of five different window 
styles and the ability to set aside windows by shrinking them down to the 
size of an icon (called tamtfying). Consequently, if you already know the 
basics, read selectively in this section to ftll in the gaps; otherwise, read the 
entire section to learn the essentials required to manipulate windows 
effectively. 

Figure 4-1 illustrates the Window menu. Be sure to have an active client 
window on your screen before attempting to use this menu; otherwise, the 
menu items are dimmed. For instructions on staning up a client, consult 
Chapter 2 "Getting Started" or Chapter 3 "Using Remote Commands.• 

• Figure 4-1 The Window menu 

lconlfy •• 
set Window Style • 
Tamp(tnnily Adorn :X:A 
Close Window •w 

While Malcolm enables you to treat client windows like regular Macintosh 
windows, it has no control over windows that open within a client window. 
According to X protocol convention, these lower-layer windows are 
controlled by the client, itself, so Malcolm simply relays the information to 
your screen. On the other hand, the client and the host it runs on have no 
control over the type of window Malcolm creates for the client. They can 
make requests, called htnt.s, but, ultimately, the X server, guided by your 
preferences, detennines what is in the realm of the possible when mapping 
out windows on the screen. 
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Window styles 

When clients open up on your screen, they appear in Macintosh-style 
windows. This style has a title bar across the top and a size box in the lower 
right comer. If you pref er a different style, follow these simple steps: 

1. Bring the window you want to restyle to the front by cllckhlg on 
It. 

2. Select Set Window Style from the Window menu to display the 
five window styles. 

Figure 4-2 shows these styles. The one currently in effect will have a 
check mark next to it. Simply highlight another style to change the 
selection. 

dient Specified, the last item in the Set Window Style menu, revens the 
window style to the one specified by the border width of a top-level 
client window. See the next section, "Specifying a window style in a 
command,• for more information. 

• Figure 4-2 Malcolm window styles 

Tille b::rir Tille hr :u1d P.ow.ded cor11er St.:i.dow Pli1i11 
size boK Solid 1ille hr 

Remember that a window must have a title bar to be moved and a size 
box to be resized. However, if you select a style without a title bar or a 
size box you can still move or resize the window by selecting Temporarily 
Adorn from the Window menu. See "Moving and Sizing Windows• for 
details. 

Specifying a window style in a command Usually top-level client 
windows displayed in a visible root window have a border, the width of 
which is specified by the client when it is invoked. In rootless mode, this 
border is not displayed; however, you can use the border width to specify one 
of the window styles in Figure 4-2, provided the client supports the border 
width option. When entering a command to start up a client, specify a 
window style by changing the argument to the border width option. 
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The procedure for specifying a border width varies depending on the client. 0, 
For MIT and MIT-compatible clients, the format of the border width option 
is: 

-bw n 

where n represents a number from 1 to 5. The style corresponding to each 
argument is: 

Argument 

1 

2 

3 
4 

5 

Wladow Style 

TJtle bar 

Title bar and size box 

Rounded corners, solid title bar 

Shadow box 

Plain box 

For example, the following command, typed in an xterm window, starts up 
the xclock client in a window with rounded corners and a solid title bar. 

XCIOCk -bw 3 

The Set Window Styles submenu contains one last item, Client Specified. 
Selecting this item causes the window style to revert to the one specified by 
the border width of the client window. For example, if you i.5sued a 
command to start up xclock with a border width of 4 (shadow box) and later 
change it to 1 (title bar), selecting dient Specified will revert the style of the 
xclock window to a shadow box. If you did not specify a border width, 
clients usually have a default border width that Malcolm will convert to a 
window style. Should this default argument be out of range (less than 1 or 
larger than 5), Malcolm substitutes a •2n in its place. 

In a rooted environment, where the root window is visible, the border width 
option functions as originally intended, that is, it specifies the thickness of 
the window border. 

Setting window preferences The Edit menu contains a Windows 
preference that sets a default window style for client windows (see Figure 4-
3). The default takes effect the next time clients starts up, unless you 
override the default by issuing a command with a border width option (see 
the previous section, •specifying a window style in a command• for 
information about this option). The window styles in Figure 4-2 apply only 
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to client windows in rootless mode, where the Malcolm Window Manager is 
in control. 

• Figure 4-3 Location of the Windows preference 

Undo XZ 

Cut XH 
Copy XC 
Paste XU 
Clear 

. . . . Monochrome Rooted Screen ... 
Fonts .•• Color Rooted Screen .•. 
Color Namer ••. 

Moving and sizing windows 

Before moving or sizing a client window, make sure it is active (in the 
foreground). Then, depending on the window style selected, you can move 
and size the window in one of two ways. If the window has a title bar, 
move it with the mouse pointer as you would any Macintosh window. If 
the window has a size box, use the mouse to drag the window's dimensions 
to whatever size you prefer. 

If the window has no title bar or grow bar, use Temporarily Adorn to move 
or size it. First, make sure the window is active. Next select Temporarily 
Adorn from the Window menu. Your window will acquire a temporary title 
bar and size box so that you can manipulate it like any Macintosh window. 
You have one opportunity to move or size your window. Once you release 
the mouse button, the window reverts to its former style. If you aren't 
satisfied with its new location or size, select Temporarily Adorn again. 

<• Stacking wi'IU/()ws: Malcolm permits you to stack client windows and 
maintains the contents of windows concealed in the stack so that they 
reappear as you left them. In other words, you don't have to wait for a 
client to refresh or restore the contents of its window when you uncover it. 
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Malcolm also allows you to move and resize a root window displayed on ,~ 
your screen just as you would a client window. A<.tually, this so-called root 
window is a Macintosh window through which you can view a virtual root 
window stored in memory. This amingement enables you to manipulate the 
root-viewing window without disturbing clients ruMing in the underlying 
virtual root window. Naturally, the root-viewing window can be smaller, but 
never larger, than the dimensiom d the virtual root window. When it is 
smaller, the scroll bars activate so that you can scroll through the entire root 
window. 

+ Scrolltng qutckly wtth the hand: To scroll quickly in root windows, 
change the mouse pointer to a hand by holding down the Option key and 
then move the root-viewing window around by holding down the mouse 
button and moving the mouse. 

In traditional X implementations, the root window never moves or changes 
size, so clients are not designed to accommodate such conditions. 
Accordingly, Malcolm will not let you resize the virtual root window while 
clients are ruMing. For more information on resizing the virtual root window 
read "Root window preferences" at the end of this chapter. 

An alternative to moving windows when they get in the way is to iconify 
them, that is, convert them into icons on your screen. You can iconify both 
client windows and root-viewing windows. In the case of client windows, 
the client can determine what the icon looks like, but if it doesn't specify 
anything, Malcolm displays a miniature Macintosh window, pictured in the 
margin. Iconified windows can be moved around with the mouse pointer, 
just like any icon on your desktop.You can return them to their original state 
by double clicking them or by clicking them and selecting Iconify from the 
Window menu. 

Malcolm provides three ways to convert a window to an icon: 

• Click the window to make it active and choose lconify from the Window 
menu 

• Press Command-I 

• Hold down the Option key and click the window's zoom box, if it has 
one. For a root-viewing window, click the close box. 

11'\ 
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While the window is iconified, any commands, calculations or other 
processes will continue to execute. When you double-dick the icon to restore 
the window to its previous size and appearance the contents of the window 
immediately reappears. 

Close Window and Kill Client are two commands that appear in the same 
location in the Window menu, depending on what type of window is active. 
When Malcolm first starts up and no windows have opened, the Window 
menu displays dose Window, as a dimmed item, in that spot. When enabled 
by an active Malcolm dialog window, such as the Remote Command 
window, selecting dose Window closes the dialog window. It's an 
alternative to clicking the window's close box or Cancel button. 

Kill Client appears only when a client window is active. It is designed to 
disconnect clients, like xclock, that provide no way to issue commands to 
them directly. It is also useful to programmers who want to stop a runaway 
program. However, Kill Client is not the preferred way to close an xterm or 
other terminal emulator window because it effects an abrupt disconnection, 
like disconnecting the telephone. Any unsaved data you had entered in a file 
would probably be lost unless the host had some way of retaining it. 

Fortunately, Malcolm does not immediately execute a Kill Client request. An 
alert box appears first inquiring whether you really want to kill the client (see 
Figure 4-4). 

• Figure 4-4 The Kill Client alert box 

Are you sure you want to kill 
the client that created the 
frontmost window? 

( OK D [cancel] 

+ Another way to kill: Clicking the close box in the left-hand corner of a 
client window is equivalent to choosing Kill Client. 
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Root window preferences 

The Preferences submenu, located in the Edit menu, allows you to select 
default settings for a monochrome or color root window. Selecting either of 
the first two items, displays a Rooted Screen Setup window. Figure 4-5 
shows the m00ochrome version; the format for the color root window 
dialog is the same. Both dialogs let you change the size of the virtual root 
window stored in memory by dragging the small, black square in the setup 
window with your mouse pointer. You can also select one of three display 
options: always display a root window, neverdisplay a root window, or 
display a root window when a client that requires one is acttve. 

• Figure 4-S The Monochrome Rooted Screen Setup window 

"'101111t ht OHIP Ruo IPll ~(I PPll ~ .. 11111 

I OK D 

[cancel) 

Any change to the Show option takes effect immediately after you click OK. 
Should you attempt to resize a root window that has clients running in it, 
however, Malcolm displays an alert box, shown in Figure 4-6. 
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• Figure 4-6 Root window warning mes.sage 

A Resizing ulrtuel screens requires that 
U ell ectlue clients be kllledl 

• If you went the changes to take effect the 
newt time this MecH document Is opened, ( Newt Time J 
select "NeHt nme". ~ ~ 

• If Immediate resizing is what you went 
(klillng 1111ct1ue clients), select "Immediate". [Immediate J 
• To discard the changes you made, select 
~~~ .~~ 

This al en box gives you the option to def er you changes until later or discard 
them all together if you would rather not kill your clients in order to resize 
the roo window immediately. 
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Managing Fonts and Color 

c l!AmR 1 INTRODUCED Tiffi FONT DIRECTOR Mll Tiffi COLOR NAMER "'ll 

briefly described what they do. This chapter covers these features in depth. 

It also summarizes the X convention for specifying font names. 

Programmers who want to create fonts should refer to the X It>gical Font 

Description Conventions, Standard VI .2 in Appendix D for a complete 

description. For those interested in compiling fonts from Adobe bitmap 

distribution font files, Appendix C provides the Bitmap Distribution Format 

2.1 standard for your reference. 

Although most of the color and font features are easy to use, the procedures 

for compiling fonts and creating new fonts can get complicated without an 

understanding of the X font standards and some solid programming 

experience. If you don't have this background, consult with someone who 

does before attempting to compile or create fonts. 
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Using fonts in Malcolm 

The method devised for inplementing fonts in Malcolm enables you to deal 
with them in a timely, efficient manner. This implementation incorporates 
three basic components: a MacX Fonts folder, a Font Directory file, and the 
Font Director. The MacX Fonts folder holds the X font files, the Font 
Directory file contains a list of these fonts, and the Font Director lets you 
view and use the fonts. 

The MacX Fonts folder, located in your System file, holds files that contain 
the standard set of X fonts. Each file contains one variation of a font. For 
example, one file contains Helvetica 18 point bold, a variation of the Helvetica 
font family. Malcolm stores a list of these fonts in the Font Directory file, 
also located in the Font folder. Since the font names in this file must 
conform to the format specified in the X logical font description standard, 
they are too long to serve as file names. Consequently, files in the Font folder 
have shorter, more obvious names, like Charter 10 bold. 

The primary purpose of the Font Directory file is to supply the Font Director 
with a current list of X fonts, any Macintosh fonts you have chosen to use 
in Malcolm, and any font aliases you have created to act as substitutes for 
font names or other font aliases. Malcolm keeps the file up to date by 
revising it any time you make a change that alters the modification date of 
the font folder. Typically, these changes include adding, deleting, or renaming 
a font file. Compiling a font in the MacX Fonts folder also updates the Font 
Directory file. 

The Font Director eliminates many of the tedious and time-consuming 
aspects of dealing with fonts in a conventional X environment. To see what 
a font looks like, you do not have to run font clients or type commands 
with long, cryptic font names in them. Instead, you can display the Font 
Director window, illustrated in Figure 5-1, click a font name, and see a sample 
of the type face. Besides viewing fonts, you can sort fonts in a variety of 
ways, assign aliases to font names, and compile fonts from BDF. files in a 
straight-forward manner by clicking buttons in the Font Director window. 
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To use the Font Director, choose Fonts from the Edit menu or press 
Command-F on the keyboard. 

• Figure S-1 The Font Director Window 

I I l'fot H F uni'\. 
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I 

( New Font ... ) 

( Remoue 

The list of fonts in the Font Director window includes all the fonts in the 
MacX Fonts folder, any Macintosh fonts you have added, and any X font 
aliases you have created. An icon precedes each item in the list to readily 
identify whether it is an X font, a Macintosh font, or an X font alias. 

The X fonnat for font names 

In Figure 5-1, the long strings of characters in the scrolling field of the Font 
Director window are font names. Font names comprise a collection of font 
elements or properties separated from each other by hyphens, a format 
required by the X logical font description standard. Font names always begin 
with a hyphen (specifically an ISO Latin 1 hyphen). A pair of hyphens in a 
font name string indicates that a font element has been omitted, not 
because it is optional, but because it does not apply to that particular font. 

Table 5-1 summarizes the format of the font name registry and suffix 
specified by the X standard. The table lists the font elements in their order of 
appearance in the font name string, starting from the left side. For more 
information, refer to Appendix D. 
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• Table S-1 X logical font name format 

Element Definition 

Registry The registration authority that owns the font (us syntax 
and semantics) 

Foundry The type foundry that digili7.ed and supplied the font 
shape or metric information 

Family name The name cl a typeface including all its style variations, 
such as bold or italic 

Weight name A name identifying a font's typographic weight, e.g. bold 
or medium 

Slant A one or two-letter code indicating the posture of the 
font, e.g., R for Roman, I for italic 

Set-width name One or two words designating the width of a font, e.g. 
Normal, Condensed, Double Wide 

Add style name A term that identifies additional type style information, 
e.g., Serif, Sans Serif. If a typeface doesn't have additional 
style information, this field is empty. 

Pixel size The number of pixels required to display a particular 
point size. The pixel size is usually equivalent to or close 
to the point size. 

Point size A number representing the height of the font in tenths of 
a point. For example, 8 points would be expressed as 80. 

X resolution A number representing the horizontal resolution of a 
font, measured in dots per inch (dpO 

Y resolution A number representing the vertical resolution of a font, 
measured in dots per inch (dpi) 

Spacing A letter that indicates the escapement class or pitch of a 
font, e.g., M for monospacing, P for proportional spacing 

Average width A number, measured in tenths of a pixel, that represents 
the unweighted arithmetic mean width of all charatters 
in a font 

Character set registry A name or string of alphanumeric characters identifying 
the organization that owns a typeface character set 

Character set encoding The character set used to associate a each charatter in a 
font with its glyph or image 
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Assigning aliases to font names 

If you find the long X font names too cumbersome or puzzling, you can 
create aliases for them. An alias is simply another name for a font. To create 
an alias, select a font name in the Font Director window and click the New 
Font button. A dialog box illustrated in Figure 5-2 will appear. The font name 
you selected should appear in the Target of Alias field. Click the New Entry 
Type pop-up menu and select Font Alias Name, as shown in Figure 5-2. Then, 
type any combination of words, letters, or numbers you prefer in the New 
Alias Name field and dick OK. The Font Director will insert the alias, along 
with any other aliases you create, into of the font name list. Aliases will be 
sorted, along with other font names, according to the font element you 
have selected from the Sort By pop-up menu. For more information about 
this process, see "Sorting Fonts" later in this chapter 

• Figure 5-2 Entering a font alias 

l Macintosh Font 
H Font 

~·flllJ•J I • lI!ll1R1IJ ;:i' .w: · OK 

( Cancel ) 

New Alles Name: 
IMyFeuoriteFont 

Target of Alias: 

I Garamond-121b 

Copying and pasting font names 

Using the Macintosh Copy command enables you to copy a font name to 
the dipboard and paste it into remote commands or into client windows. 
First, select a font name in the Font Director window and then copy it, 
either by pres.sing Command-C on the keyboard or by choosing Copy from 
the Edit menu. To paste your selection into a remote command, pull down 
the Remote menu and choose a command from the Edit Command submenu 
or choo.se New Command. When the Remote Command window appears, 
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click the spot in the command string where you want the font name to 
appear and paste it in, either by pres.sing Command-V or by choosing Paste 
from the Edit menu. 

Once a font name is in the Oipboard you can also paste it into a client 
command or fde by using that client's equivalent paste or insert command. 
For example, you could paste the font name into a command in the xterm 
window by pressing the Left Arrow key, the Macintosh equivalent to the 
middle mouse button on a three-button mouse. 

Removing fon1S and font alJases 

The Remove button removes a font or font alias from the Font folder and 
deletes its name from the Font Directory file and the font names list in the 
Font Director window. Deleting a font name does not delete the aliases 
associated with it, however. To remove a font or alias, select its name in the 
Font Director window and click the Remove button. A dialog box appears 
asking whether you really want to remove the font (see Figure 5-3). Click OK 
to remove the font or Cancel to retain it. 

• Figure S-3 Removing a font 

are you sure you went to 
•permanently* delete the 
selected fonts? 

( OK ) (cencel] 

Chapter 5: Managing Fonts and Color Apple Confidential 5/30/89 



( 

•.•... ,. 
Feund111 
Femllu ., ...... 
Slent 
Set-Wl11th 
Style 
Pl11el Size 
1'111111 Size 
N le1olut11111 
' ... olutlotl 
Spec Ing 
........ Ulldth 
ci. ... cter Set 

Apple Confidential 

Sorting fonts 

The pop-up menu in the margin shows all the ways you can sort font names 
in the Font Director window. Since the items in the menu are font elements, 
you can sort font names by any element you desire. The order in which the 
Font Director sorts font names, however, depends on a number of factors. 
Here is a list enumerating the sorting order: 

1. First, the Font Director sorts font names by the element chosen. 

For example, if the sorting element is Weight, all boldface fonts appear 
first, followed by medium-weight fonts, and so forth. 

2. Next, the Font Director sorts successively, character-by character, 
starting with the first element and moving right 

Since Registry is optional for fonts that conform to the X logical font 
description standard, this field is empty and the first element is Foundry. 
Starting with the Foundry name (such as Adobe) the Font Director sorts 
font names within the boldface group one character at a time, continuing 
in this manner through the last element (Character Set). 

The way numbers are sorted depends on whether the element chosen to sort 
by is alphabetic or numeric. If it is alphabetic, numbers appear to sort out of 
order because each character in multicharacter numbers, like 10 is sorted 
individually. Since a 1 is smaller than an 8, the Font Director sorts 10 before 8. 
For example, the following font names are sorted by Family, an alphabetic 
field: 

-adobe-times-bold-1-norma1--12-120-
-adobe-times-bold-1-norma1--14-14C-
-adobe-t i m es-bo 1d-i-norma1--22-220-
-adobe-t i mes-bo ld-1-normal--8-80-

Sorting font names numerically makes numbers appear in proper ascending 
order, because a numeric sort treats multicharacter numbers as one character. 
The same example, shown above, sorted by the numeric field, Pixel Size, 
appears in the following order: 

-adobe-t imes-bo ld-1-norma 1--8-80-
-adobe-t imes-bo ld-1-norma 1--12-120-
-adobe-times-bold-i-normal--14-140-
-adobe-times-bolo-1-normal--22-220-
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The following font name elements are numeric: 

Pixel Size 
Point Size 
X Resolution 
Y Resolution 
Average Widlh 

Compiling fonts from BDF files 

The Font Director enables you to compile BDF files into fonts without 
exiting from Malcolm. Although BDF files can be compiled in the MacX 
Fonts folder, compiling them in another folder and moving them to the 
fonts folder afterwards saves considerable time. You can trigger Malcolm to 
update the Font Directory file once you have moved the compiled font files 
into the fonts folder by opening the folder. Otherwise, the Font Directory 
file will automatically be updated the next time you start up Malcolm. 

To compile a font, follow these steps: 

1. Click the New Fonts button on the Font Director window. 

When the New Entry dialog box appears, select X Font from the New 
Entry Type pop-up menu. The layout of the box will change, as depicted 
in Figure 5-4. 

• Figure S-4 Compiling an X font 

New Entry Type: l.__H_F_o_n• ___ ... 01( 

(Cancel ) 

Compile e BDF file ••• 
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2. Click the C.Omplle a BDF File button. 

The Directory dialog box will appear. 

CJ Apple Lint 
CJ Claris Software 
CJ DistEHpress 
Cl Documentation 
CJ GelaHy 
CJ Hypercerd 
CJ In BoH 
CJ MecH 1.0d9 

c::::ichez Metz 

i: }ec t 

Driue 

Open 

Cancel 

3. Locate and open the folder containing the BDF files you want to 
compile. 

Check the name of the disk at the top right of the directory box to verify 
it is the one you want. The Directory title bar above the scrolling window 
indicates whether the items displayed in the window are at the top level 
of the disk or in a folder. If the bar shows an open folder icon, dicking on 
the bar will reveal the hierarchy of directories (folder names) through the 
top level. Upon finding the right directory level, if your folder isn't visible 
you can type a letter, word, or number to scroll directly to the folder 
name, if desired. 
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4. Select a BDF me J11J11e and click Open or double click the name. 

An alert box advising you that the font compiler is compiling your BFD 
source file will appear. When the box disappears, the compiled font file 
will be in your folder. 

The font compUer is compiling your 
DFD source file. 

Please stand by ... 

5. Repeat steps 2 through 4 for as many files as you want to 
compile. When you have finished, drag the files into the MacX 
Fonts folder in your System file. 

Malcolm will update the Font Directory file. This process will take at least 
30 seconds. If you don't care to wait that long, defer this step until later. 

Using Color in Malcolm 

In a departure from other X servers, which represent colors in numeric form 
only, Malcolm offers a visually oriented approach to specifying colors. 
Traditionally, the differing amounts of red, green, and blue that constitute 
colors are expressed as sets of three numeric values. In Malcolm, these sets of 
numbers are stored with corresponding color names in the MacX Colors file. 
Malcolm converts these values into colors and displays them in a dialog 
window called the Color Namer. 
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The Color Namer eliminates the chore of reprcxlucing colors in X. Instead of 
having to visualize the color you want and experiment with numerical red, 
green, and blue values until you hit upon the correct combination, you can 
simply open the Color Namer Window, shown in Figure 5-5, and browse 
through a long list of color samples until you find the one you want. If the 
color isn't in the list, you can create a new one or modify an existing color. In 
addition, you can re~ve colors, change color names, and copy color names 
to client commands. 

To display the Color Namer window, choose Color Namer from the Edit 
menu. 

• Figure S·S The Color Namer window 

0 f olor NilffiPI 

l( OK I 

Brown 
Cadet Blue 
Corel 
Cornflower Blue 
Cyan 
Dart Green 

( Cancel 

( New 

Remoue 

(Set Color ... ) 

(set Name ... ) 

Sorting, scrolling, saving, and cancelling 

Sorting color names Any time you make a change that adds, removes, or 
modifies color names, the Color Namer resorts the color list alphabetically. 
The sorting method used ignores upper and lowercase, spaces, and diacritical 
marks, such as an umlaut C'). Any numbers at the end of a color name are 
sorted numerically, as whole values. For example, the color Grey8 would 
appear before the color GreylO. 

Chapter 5: Managing Fonts and Color 67 



68 

Scrolling To expedite the task of finding colors in a long list, the Color 
Namer supports all the standard Macint<lSh scrolling methods. Besides 
responding to the scroll bar and the directional arrows (Ulustrate up, down, 
left, right arrows here), the Color Namer will scroll to names in the Ii.st that 
match a letter, word, or number typed at the keyboard. For example, to scroll 
to colors beginning with •s, • type •s• when the C.olor Namer window is 
visible. Type •grey" and the Color Namer will scroll to the first color named 
•grey" in the list Similarly, typing •50" will produce the first color name 
starting with that number. 

smna or canceling changes When you have fini.shed using the Color 
·Namer, click OK to save any changes and clClSC the Color Namer window. 
Oicking Cancel closes the window without saving any changes. For example, 
if you've made a color change you don't like, clicking Cancel will prevent it 
from taking effect (along with any other changes as well). Clicking the close 
box also clClSCS the Color Namer. However, if you modified any colors or color 
names, an alert box appears asking whether you want to save these changes 
before cl<lSing the Color Namer. 

Adding new colors 

To add a new color, click New in the Color Namer window. First a dialog box 
will appear requesting that you enter a name for the new color. 

• Figure S-6 Entering a new color name 

Please enter e name for thet color 

I GIC I Cancel 

Chapter 5: Managing Fonts and Color Apple Confidential 5/30/89 



Apple Confidential 

Next, the Color Wheel dialog box, displayed in Figure 5-7, will appear. dicking 
anywhere in the color wheel will display the selected color in the top half of 
the box directly beneath the legend •please select a color.• Keep clicking in the 
color wheel until the box displays the color you want, then click OK. The 
color will appear in alphabetical order in the Color Namer Window. 

• Figure S· 7 The Color Wheel dialog box 

Please select • color 

Hue 4:5690 Ii) 
soturation 655:55 IIJ 
Brightness 655:55 m 

Red~!;) 
&reen O Ii) 

Blue 655:55 Ii) 

1111 

:j,iji 

( C1mcel ) n OK B 

The scroll bar to the right of the color wheel controls color brightness. 
Scrolling the elevator down makes colors darker; up makes them brighter. For 
more information on the color wheel read "Using the C:Olor Control Panel,• in 
the Macintosh Sys/em Software User's Guide, Version 6.0. 

Removing colors 

To remove a color, click its color name and then the Remove button (see 
Figure 5-5). A warning box enquiring "Are you sure you want to remove that 
color?" will appear. Click OK to remove the color or click Cancel to retain it. 
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Changing colors and color names 

Changing a color is similar to adding a new color. Simply double-click the color 
sample you want to change or click the color sample and then click the Set 
QJlor button The Color Wheel dialog box shown in Figure 5-7 will appear. At 
the top left, the sample color box displays the existing color. As you click the 
color wheel, the top half of the box will rcfted the color choices you have 
made, while the bottom half retains the original color so that you can 
compare them. When you find the color you want, click OK. The Color Namer 
window will reappear showing the changed color. 

If, for some reason, you made a mistake and want the original color back, 
selecting C1ncel will dme the Q>lor Namer and discard any changes you 
made. Alternatively, if you remember the red, green, and blue or the hue, 
saturation, and brightness numerical values for the original color, typing 
either set ci these numbers in the appropriate fields in the Color Wheel box 
will restore the color, too. 

To change a color name, select the name by double-clicking or using the Set 
Name button. The Color Namer will display a dialog box like the one in Figure 
5-6 so that you can enter another name. 

Copying and pasting color names 

Using the Macintosh copy command enables you to copy a color name to 
the Clipboard and paste it into remote commands or into client files or 
documents. First, select a color name in the Color Namer window and then 
copy it, either by pres.sing Command-Con the keyboard or by choosing Copy 
from the Edit menu. To paste your seledion into a remote command, pull 
down the Remote menu and select a command from Edit Command 
submenu or choose New Command. When the Remote Command window 
appears, click the spot in the command string where you want the color 
name to appear and paste it in, either by pressing Command-V or by seleding 
Paste from the Edit menu. 
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Once a color name ~ in the Clipboard you can also paste it into a client 
command or file by using that client's equivalent paste or insert command. 
For example, you can paste a color name into a command typed in the xterm 
window by pressing the Macintosh equivalent to the middle mouse button: 
the left arrow key. Thus, pasting •seagreen• into the command 

xclock -t>g seagreen 

starts up an xclock with a sea-green background. 
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Troubleshooting 

c ONSULT TilB CHAYJ'ER WHEN MALCOLM DBPLAYS AN ERROR MESSAGE AND 

you aren't sure what to do. Often the problem is easy to fix. In some cases 

the problem may involve your network or the host you are trying to reach, 

rather than Malcolm itself. If the problem does involve Malcolm and you 

aren't able to find a solution in this chapter, the Technical Support Group at 

Apple Computer is ready to help. 
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About errors 

Malcolm displays different types of error messages depending on the type 
and severity of the problem. If the problem involves a malfunction of 
Malcolm, the Macintosh hardware, or the operating system, Malcolm will 
display an alert box containing the phrase •Sony-an internal error has 
occurred: .... • Figure 6-1 illustrates this type of alert box. 

• Figure &-1 Sample internal error alert box 

I OK I 

sorry - en 1nternal 
error bes occurred: 

Usually, you can do nothing to fix this kind of problem yourself. Any time 
Malcolm displays an internal error message, call Technical Support at Apple 
Computer. 

Another set of errors will make Malcolm quit or prevent Malcolm from 
starting up. The phrase identifying these errors is "Sorry-an unexpected 
error has occurred: ... • Figure 6-2 illustrates the alert box displayed in this case. 

• Figure 6-2 Sample alert box for an unexpected error 

I OK ) 

sorry - an uneHpected 
error bas occurred: 
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Fortunately, you can usually recover from these types of errors. Refer to the 
section in this chapter that covers the type of problem you encounter. 

The last type of error message Malcolm might display is a warning (see 
Figure 6-3). Warnings nonnally advise you of minor problems, such as a field 
you forgot to fill in. 

• Figure 6-3 Sample warning message 

( OK I 

An error (-61) occurred 
while seulng your settings 
document 

For assistance with warnings, refer to the section in this chapter that covers 
the type of warning you encounter. 

Problems opening Malcolm 

The following messages describe errors that prevent the Malcolm application 
or a Malcolm settings document from starting up. Except where indicated, 
these errors appear in the unexpee1ed-error alert box depicted in Figure 6-2. 

Malcolm uses a font, called "fixed," when writing text in client windows, in 
cases where the clients, themselves, haven't specified a font for this purpose. 
Malcolm will not open if it cannot open this default font. 

Ifyouseethemessage" ... could not open the default font.,"follow 
these steps: 

1. Verify that the "fixed" font file is in your MacX Fonts folder. 

CJ If it is, drag the file to the trash and replace it with a known good file. 
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o If it isn't, drag a copy from the MacX Fonts folder on your master 
disk into the MacX Fonts folder in your System Folder. 

2. Try opening your Malcolm application or settings document 
again. 

Could not open the default A font, called •cursor,• comprises all the cursors used in x Malcolm will not 
open if it cannot open the cursor font. 

cursor font 

Unable to open MacX 
Temp 
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If you see the message • ... could not open the default cursor font.," follow 
these steps: 

1. Verify that the "cursor" font file is in your MacX Fonts folder. 

o If it is, drag the file to the trash and replace it with a known, good file. 

o If it isn't, drag a copy from the MacX Fonts folder on your master 
disk into the MacX Fonts folder in your System Folder. 

2. Try opening your Malcolm application or settings document 
again. 

The message, • ... unable to open MacX Temp.,• appears when you try to 
launch Malcolm or a Malcolm settings document and Malcolm cannot create 
the MacX Temp file. This problem can occur for a number of reasons. Read 
the following check list to ascertain which problem applies in your case and 
what corresponding solution to apply: 

1. Do you have sufficient RAM? 

Select About the Finder in the ti menu and check the Total Memory field 
to see how much RAM your Macintosh has.On Figure 6-4, the total 
memory available is 4 Megabytes.) If your system is running Multifinder, 
it should have at least 2 Megabytes to operate smoothly; otherwise, turn 
off Multifinder and try launching Malcolm again. 
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• Figure 6-4 About the Finder display 
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If your system has plenty of memory available to support Multifinder, 
you still may not have enough memory left over to run Malcolm. To 
determine whether this case applies, click the Malcolm icon, select Get 
Info from the File menu, and check the field labeled Application Memory 
Size (K). See Figure 6-5 for an illustration. This amount should not be larger 
than the largest unused block shown in •About the Finder." If it is, you 
have a number of alternatives. 

o Close other applications running under Multifmder. In Figure 6-4, 
AppleLink® and Microsoft Word could be closed to free more 
memory. 

o Remove unnecessary inits (initialization programs), cdevs (Control 
Panel devices), and fonts from your System Folder. Simply drag the 
inits and cdevs you don't need out of your System Folder. To remove 
fonts, use the Font/DA Mover. In both cases, if you are running 
Multifinder, reboot your Macintosh to make these changes take 
effect. 

o Select the Control Panel from the ti menu and turn the RAM cache off 
or reduce the amount of RAM set aside for it. 

o Decrease the application memory size for Malcolm below the size of 
the largest unused block. Malcolm requires a minimum of 768K to 
operate. Make sure Malcolm isn't locked or you won't be able to make 
this change; the box labeled Locked in the upper right comer of Get 
Info should not be checked. 
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• figure 6-5 Get Info Display for Malcolm 
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As a last resort, if none of these alternatives is a good solution in your 
case, you can always buy more RAM for your machine. 

2. Is your System Folder on a floppy disk? 

Make sure the disk isn't write-protected. Verify you cannot see through 
the square hole on the top right side of your disk. Otherwise, slide the 
black locking tab down so that the hole is blocked. 

3. Is the disk you are using defective? 

Run the Macintosh utility called Disk First Aid™ or an equivalent to 
ensure your disk is OK. The MactntoSh Utilities User's Gulde contains 
instructions for using Disk First Aid. 

After fixing the problem that occurred in your case, check your System 
Folder and remove any existing MacX Temp file. Be sure to quit Malcolm first 
and then drag the MacX Temp file from your System Folder to the trash. 
Now try starting up Malcolm again. 
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When starting up Malcolm, if the error message • ... none of the connection 
tools are working at the moment. Check that they are properly installed." 
appears, check with your network administrator to verify that the network 
is up. If the network is up, consult the installation procedures for your 
connection tools to verify they are installed correctly. If everything is in 
order, restart your Macintosh and try starting up Malcolm again. If the same 
message recurs, call Technical Support for further assistance. 

If your settings document is corrupted, Malcolm will display the warning 
message, "An error occurred when opening or reading your settings 
document-a new 'Untitled' one will be used instead.• in the alert box 
depicted in Figure 6-3. Chances are the document is unusable. The message 
advises you that Malcolm has opened a new settings document since it could 
not open the one you specified. Be sure to throw this damaged document 
away. 

The full text of this warning message is "One or more 'Auto Execute' 
commands could not be started because of insufficient memory: Although 
your settings file was able to open, your system does not have enough RAM 
to automatically execute one or more remote commands. To ensure that you 
have at least 768 Kilobytes of RAM available to run Malcolm, select About the 
Finder in the ti menu. If the Finder indicates less than 768K of RAM is 
available, try one or more of the following alternatives: 

o Clase other applications running under Multifinder. In Figure 6-4, 
AppleLink and Microsoft Word could be closed to free more memory. 

o Remove unnecessary inits (initialization programs) and cdevs (Control 
Panel devices) from your System Folder. Simply drag the inits and cdevs 
you don't need out of your System Folder. In both cases, if you are 
running Multifinder, reboot your Macintosh to make these changes take 
effect. 

o Select the Control Panel from the ti menu and turn the RAM cache off or 
reduce the amount of RAM set aside for it. 
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o Decrease the application memory size for Malcolm below the size of the 
largest unused block. Malcolm requires a minimum of768K to operate. 
Make sure Malcolm isn't locked or you won't be able to make this change; 
the box labeled Locked in the upper right comer of Get Info should not be 
checked. 

If none of these alternatives is a good solution in your case, you can always 
buy more RAM for your machine. 

Problems with remote commands 

Messages in this section describe errors that prevent remote commands 
from executing. Some of these errors involve problems with the host or 
network specified in the command. Others result from lack of sufficient 
memory. 

If, while preparing to execute a remote command, Malcolm cannot translate 
the host name specified into a network address, the warning "Remote 
command did not succeed: the specified host name could not be translated 
into a network address.• will appear. To correct this problem, you must 
properly define the host name and its corresponding network address. 
Consult the documentation for the connection tool being used for 
instructions or contact your network administrator for assistance. 

The warning "Remote command did not succeed: a network 
communications error occurred.,• can appear for an number of reasons, 
enumerated below: 

1. The host specified in the remote command or the network is 
down. 

Call your system and network administrators to verify the status of the 
host and network. 

2. The conncctlon tool spedfled in the remote command is 
malfunctioning. 
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Consult the troubleshooting section of the documentation for that 
connection tool. 

3. Makolm has depleted its allocated memory. 

Some operation.5 in Malcolm use a IOl d memory. Furthennore, doing a 
lot of things at once can also deplete memory resources allocated to 
Malcolm. Try the following suggestions to free memory: 

o Close any color, rooted, or large windows that you don't need to use 
presently. 

o If you are using numerous connection tools to run several sessions, 
close some d these connections. 

c Close clients that are using large pixmaps. <How can one te 11? J 

o Reduce the number of different fonts being used at the same time. 

o Lower the number of command output lines in the Saved Lines field of 
your remote commands to 100 lines or fewer. 

o Close the Font Director or Color Namer windows if they are open. 

When you see the message, "Remote command did nOl succeed: internal 
error," call Technical Support for assistance. 

Malcolm displays one of two messages when it runs out of memory while 
processing a command. These messages are: "Remote command did not 
succeed: there was not enough memory to perform the operation." and 
"There is not enough memory to store the remote command in the Malcolm 

·document.• The latter warning will appear when you attempt to save or 
execute a remote command you have just edited or created and Malcolm does 
not have enough memory to store it. To create more memory, follow these 
steps: 

1. Verify that Malcolm hasn't used up all the RAM allocated to it. 

Some operations in Malcolm use a IOl of memory. Furthennore, doing a 
lot of things at once can also deplete memory resources allocated to 
Malcolm. Try the following suggestions to free memory: 

o Close any color, rooted, or large windows that you don't need to use 
presently. 
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a If you are using numerous connection tools to run several sessions, 
close some of these connectiom. 

a Oose clients thatare using large pixmaps. (How can one tell?) 

a Reduce the number of different fonts being used at the same time. 

a Lower the number of command output lines in the saved Lines field of 
your remote commands to 100 lines or less. 

a Oose the Font Director or Color Namer windows if they are open. 

2. Allocate more memory to Malcolm. 
First, quit from Malcolm if it is running. Next, click the Malcolm icon and 
select Get Info from the File menu and increase the amount of memory 
in the field labeled Application Memory Size (K.). (See Figure 6-5 for an 
illustration of the Get Info display.) The minimum amount of memory 
Malcolm needs to operate is 768K, but 1,200K is preferable. Depending on 
your system configuration and how you use Malcolm, however, you may 
need more or less than l,200K. In any case, be sure not to make the 
application memory size close to or larger than the total RAM in your 
Macintosh. To find out what the total memory is select About the Finder 
from the ti menu. 

Problems with fonts 
Messages in this section describe errors that prevent Malcolm from updating 
the Font Directory file or prevent you from using a font. Figure 6-3 depicts 
the type of alert box in which these warnings appear. 

The full text of this warning is "An error occurred while attempting to 
update the 'Font Directory' fde. It will be left unchanged: You will probably 
not be able to open new fonts until the Font Directory file can be updated. · 
Since this problem can occur for a number of reasons, perform the 
instructions for each of the following steps until you solve the problem that 
applies in your case: 
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1. Is the Font Ditec:tory 81e locked? 

Find the Font Directory fde in the MacX Fonts folder. Click the file icon, 
select Get Info from the File menu, and en.sure that the box labeled 
Locked in the upper right comer of the Get Info box is not checked. 

2. Is the dJsk you att using defectlvd 

Run the Macintosh utility called Disk First Aidni or an equivalent to 
en.sure your disk is OK. The Macintosh UtilU1es User's Guide contains 
instructions for using Disk First Aid. 

3. Does Malcolm have suffldent RAM? 

Some operations in Malcolm use a lot of memory. Furthermore, doing a 
lot of things at once can also deplete memory resources allocated to 
Malcolm. Try the following suggestions to free memory: 

o Close any color, rooted, or large windows that you don't need to use 
presently. 

a If you are using numerous connection tools to run several sessions, 
close some of these connections. 

a aose clients that are using large pixmaps. <How can one te 11 '? J 

o Reduce the number of different fonts being used at the same time. 

o Lower the number of command output lines in the Saved Lines field of 
your remote commands to 100 lines or less. 

o Oose the Remote Command, Font Director, or Color Namer windows 
if they are open. 

o Delete the remote command output for commands that have exited. 
To delete this output, select the Command Output submenu from 
the Remote menu. 

4. Is your System Folder on a write-protected disk? 

Make sure the disk isn't write-protected. If it is a floppy disk, verify you 
cannot see through the square hole on the top right side of your disk. 
Otherwise, slide the black locking tab down so that the hole is blocked. 
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S. Is your disk full? 

Check the upper right caner of your disk directory folder for the amount 
of available RAM. 

If a font file is corrupted, Malcolm will display the warning •for some 
reason, the font property of the font file font name couldn't be IO'dded This 
font will be left out of the Font Directory list and thus will be unavailable 
for use.• When this error occurs, drag the corrupted font file to the trash and 
get a new copy of the file from your Malcolm distribution disk or compile a 
new font fde. See Chapter 4 for instructions about compiling fonts. 

Problems saving a settings file 

Several types of errors can prevent Malcolm from saving a settings 
document. Each of these errors generates the warning "Sorry-an error 
occurred while saving your document.• Perform the instructiom for each of 
the following steps until you solve the problem that applies in your case:. 

L Does Malcolm have suftldent IWU 

Some operations in Malcolm use a lot ci memory. Furthermore, doing a 
lot of things at once can also deplete memory resources allocated to 
Malcolm. Try the following suggestions to free memory: 

o dose any color, rooted, or large windows that you don't need to use 
presently. 

o If you are using numerous connection tools to run several sessions, 
close some ci these connections. 

o dose clients that are using large pixmaps. <How can one tell?) 

o Reduce the number of different fonts being used at the same time. 

o Lower the number of command output lines in the Saved Lines field of 
your remote commands to 100 lines or less. 

o dose the Font Director or c.olor Namer windows if they are open. 
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2. Is the disk you are using defective? 

Run the Macintosh utility called Disk First Aid or an equivalent to ensure 
your disk is OK. The Macintosh Utilities User's Guide contains 
instructions for using Disk First Aid. 

3. Is your System Folder on a write-protected disk? 

Make sure the disk isn't write-protected. If it is a floppy disk, verify you 
cannot see through the square hole on the top right side of your disk. 
Otherwise, slide the black locking tab down so that the hole is blocked. 

4. Is your disk full? 

Check the upper right corner of your disk directory folder for the amount 
of available RAM. 
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Installation 

T 0 INSTALL MACX ON YOUR MACOOOSH SL•PLY VERIFY THAT YOU HAVE lJlE 

right equipment and software and then follow the instructions to set up a 

communications link and install MacX. Besides providing this information, 

this chapter illustrates different ways you can set up equipment to best suit 

your needs. 
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What you need to run MacX 

Read this secti90 to ensure that you have the equipment, system software, 
and communications software required to run MacX properly in your 
network environment. 

MacX, version 1.0, will run on any Macintosh with at least 1 Megabyte of 
memory, a 12.8K or larger ROM, and a minimum of two floppy disk drives. 
With the exception of early models, the current line of Macintoshes, ranging 
from the Macintosh Ilx through the Macintosh Plus meet these 
requirements. MacX will operate at its best, however, if your Macintosh has 
2MB or more of RAM and a hard disk drive. 

Like all X servers, MacX requires monitors with bit-mapped screens. MacX 
will support both color and monochrome displays. 

MacX requires that Macintosh operating system software (MacOS) be 
version 6.0.2 or later. MacX is fully compatible with MultiFinder, but requires 
at least 2MB of RAM for best performance. 

Version 1.0 of MacX uses the Communications Toolbox to manage 
communications and to install connection tools, an Apple term for network 
and transport-layer communications protocols. The connection tools 
supplied with the first version of MacX are MacTCP, Apple's TCP/IP product 
for the Macintosh, and ADSP (AppleTalk Data Stream Protocol). Third-party 
vendors are supplying other connection tools. Basically, MacX will support 
any duplex-reliable, 8-bit byte-stream protocol that operates under the 
Communications Toolbox. 
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Your MacX package should contain the items illustrated in Figure 7-1: 

• Figure 7-1 What you should have 

• Three MacX disks (how labeled?) 

• One disk containing the Communications Toolbox and the MacTCP and 
ADSPconnectiontools (Comm Toolbox and AOSP provtded later.> 

• The MacX User's Guide 

• The MacTCP Network Admtnistrator's Guide 

• This installation booklet 

• A license agreement and software registration card 

If any of these items are missing, contact the authorized Apple dealer from 
whom you purchased the product. 

Sample configurations 

MacX will operate in a number of network configurations. To demonstrate 
the extent of these possibilities, Figures 2 through 4 present examples 
ranging from the simplest setup to an extensive multiple-network 
configuration. 
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• Figure 7-2 A small local Area Network 

Macinlosh II 
VAX 

···---i~--..... -..------------· 
fr.ill 
~ 

Macinto&h lier Macintc5h SF/30 

• Figure 7-3 A small internet 

.Macinllllh II Macinlosh Da Macinto&h II 

... _._,. ___ ...._ ______ ,....IL.I 

Macin1o&h SE 

rs:;) 
a;;J:;I 

.Macinllllh II : . 

I ,-

VAX 

LaserWriter 

.MICinlolh Ila 

Apple Confidential 5/30/89 



( 

Apple Confidential 

• Figure 7-4 A large internet 
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Installing the Communications Toolbox 
The Communications Toolbox is a nifty piece of software that makes your 
connection tools talk to MacX whether they want to or not... 

Congratulations, you finished installing the Comm Toolbox! Now you're 
ready to install a connection tool. 
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If you don't know whether the hosts with which you want to 
communicate on your network are using AppleTalk or TCP/IP protocols, call 
your network or systems administrator. Once you've identified which tool 
to install, you will need to get configuration information pertaining to that 
tool. Therefore, before ending your conversation, tum to the section about 
installing ADSP or MacTCP and get the additional information you need. 

Installing ADSP 

This section describes how to install an ADSP connection tool. The 
connection tool disk that came with your MacX disks contains an ADSP 
driver, software that enables your Macintosh to communicate over an 
AppleTalk network. Because the low-level AppleTalk protocols are already 
included in your system software, installing the ADSP driver takes just a 
couple short steps. 

Installing MacTCP 

This section describes how to install a MacTCP connection tool. The 
connection tool disk that came with your MacX disks contains a MacTCP 
driver, software that enables your Macintosh to communicate over a TCP/IP 
network. The procedure for installing MacTCP includes dragging the MacTCP 
driver into your System Folder, then bringing up the Control Panel and 
configuring the driver to conform with your network's implementation of 
TCP /IP. In order to configure the driver properly, you need to call your 
network administrator and ask htm or her a variety of questtons. This 
section explains this whole process. It addresses the needs of the network 
user who simply wants to connect a Macintosh to an existing TCP/IP 
network. If you are a network administrator or are installing a TCP/IP 
network, please consult the MacTCP Administrator's Gutde, included in the 
product package. 

Follow these steps to install MacTCP on a hard disk or a floppy disk: 
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L Lock your connection tool disk before inserting it into your 
floppy disk drive. 

Locking the disk ensures that you don't accidentally erase something 
while you are transferring MacTCP onto your hard disk. The disk is locked 
when you can see through the square hole on the top right side of the 
disk. 

2. Insert the disk in your floppy disk drive and double-click the d~k 
icon to open the disk. 

Figure 7-5 illustrates the contents of this disk. 

• Figure 7-5 Contents of the connection tool disk 

If you do not have a bard disk, insert a floppy disk that contains a 
System Folder with version 6.0.2 or later of the Macintosh 
operating system into your other floppy drive. label this disk 
"MacX System Disk" or something similar. 

3. Drag the MacTCP icon into your System Folder 

4. Open the Control Panel, scroll until you see the MacTCP icon, 
and click it. 
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a flpre 7-6 The MacTCP Control Panel 

• • Mlp 

Control Panel 

KP 
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Figure 7-6 illustrates the MacTCP Control Panel. The upper part of the 
panel displays one or more icons labeled LocalTalk, EtherTalk, or Ethernet. 
These represent the cabling method employed in your network. 
Configuration of MacTCP depends on the type of cabling method in 
place. What icon or icons do you see? 

o LocalTalk: Oick the icon and go to •LoalTalk or EtherTalk cabling 
method• 

o EtherTalk: Oick the icon and go to •LoaITalk or EtherTalk cabling 
method• 

o Ethernet: dick the icon and go to •Ethernet cabling method• 

o One or more of these icons: Click one of the icons and go to the related 
section 

In the case of multiple icons, selecting an EtherTalk or Ethernet icon, if 
available, will produce faster data transmission. 

If you selected the LocalTalk or EtherTalk icon from the MacTCP Control 
Panel (Figure 7-6), as desaibed in step 4 above, follow the steps in this 
section to configure the MacTCP driver. 
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How to procted C.Onfiguring MacTCP is a two-part process. The first part 
involves calling your network administrator to obtain the information 
specified in steps 1 through 3. Read these directions before calling the 
administrator so that you are familiar with the questions you have to ask. 
After obtaining the information required, you need only follow the 
instructions for filling in the C.Onfiguration Panel and you're finished. 

Ask your network administrator the following questions: 

1. Does the network use a domain name server? 

Yes: Go to step 2 

No: Ask for the location of the Hosts file. This file maps machine 
names to internet addresses. Go to step 2. 

l Is the network using a DDP·IP gateway, like Kinetics Fast Path? 

If not, one must be installed for MacTCP to work. (DDP-IP stands for 
Datagram Delivery Protocol-Internet Protocol.) 

3. Upon verifying that your network has a DDP-IP gateway, ask for 
the following information: 

o Whatwne should Iseled? ------------
A zone identifies individual networks within a group of 
interconnected networks (an internet). You need to find out the zone 
that contains the DDP-IP gateway. 

o Whatdomainamiin? ____________ _ 

A domain is a text version of the IP address. 
Record the name of the domain in the space provided. If you are in 
two domains, see the note below. 

D What is my IP address?------------­
An IP address is a binary number that identifies a host and the 
network on which it resides. It is inserted in data packets to specify 
their destination 

+ 7ioo domains: If you must enter two domain names, find out which 
domain is the default. Later, when filling out the Configuration Panel, 
you will click the default button for that domain. 

4. · Select the zone from the pop-up menu on the C.Ontrol Panel 
Figure 7-6 identifies the location of this menu. 
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S. Click the More button shown at the bottom of the Control Panel 0' 
When the Configuration Panel appears, enter the domain information you 
obtained. rigure 7·7 illustrates the Configuration Panel. 

• flpre 7· 7 The MacTCP ConfJ8Wltion Panel 

r;:Obtetn Address:! ~IP Address: 

I O Manually ! I Cl•::~ M~ddress: o.o.o.o 
. ® Seruer j 1 Subnet Mask: 255.255.252.0 

I 0 Dynemicelly 11 111111111111111111111 [t 111111111 I ! I Net I Subnet I Node 
1 i I Bits: 8 14 1 o 
I I. 
! : i Net: ro-------; D 1.<1ck 
I Ii ~~==:=-~ 

-- I Subnet: io i D l.<u k 
r .. Rout1ng lnformet1on:·1 ! '·::::::::::.~:::=~-~:=::; : l Gateway Address: I ! Node: @: ____ j D Lo< I< ! 
i ro.ofo ....=-=.:i I r':.:: .. 0;;;;1;N;-,;-;.-;~;~-i-~t;met'i~~~::~~-~:~~; 
I ---.l Domain IP Rddress Default ! l!' 11,.,.,, I ® fl l t II I Obj! l OK J [ Cancel ] -·-- -- . ________ _j 
o Domain name, IP address, and default button 

Enter this information in the section labeled Domain Name Server 
Information and click the default button. If you enter two domain 
names, click the button for the domain your network administrator 
indicated is the default. 

6. Click the Server button in the Obtain Addtcg area of the 
Conflpradon Pand and dick OK to return to the Control Panel 
Close the Control Panel 

7. If your network bas a domain name server, restart your Macintosh 
to ac:ttnte the cooflguradon changes and you're ready to go. 

'If your network does not have a domain name server, drag your 
network's Hosts file Into your System Folder. Then restart your 
· Madostosh and your're ready to go. 
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Your network administrator will explain where to get the Hosts file. If 
no such file exists, you or your network administrator will have to create 
one. (Thi.s situation seldom occurs.) See Appendix A in the MacTCP 
Administrator's Guide for instructions. 

If you selected the Flhernet icon from the MacTCP C.Ontrol Panel (Figure 7-
6), as described in step 4 above, follow the steps in thi.s section to configure 
the MacTCP driver. The first part of this process involves calling your 
network administrator to obtain the information specified in steps 1 
through 2 and in one of the protocol-specific subsections that follows. Read 
these directions before calling the administrator so that you are familiar with 
the questions you have to ask. After obtaining the information required, you 
need only follow the instructions for filling in the Configuration Panel and 
you're finished. 

Ask your network administrator the following questions: 

1. Does the network use a domain name server? 

Yes: Go to step 2 

No: Ask for the location of the Hosts file. This file maps machine 
names to internet addresses. Go to step 2. 

2. Which of the following protocols, if any, does the network use? 

o RARP (Reverse Address Resolution Protocol) 

o BootP (Bootstrap Protocol) 

o RIP (Routing Information Protocol) 
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Check ooe of the following possibilities and go to the related section 
starting on the next page: 

Uses all three: Go to "Ertering configuration settings" 

Uses RARP and BootP: Go to -a.ARP and BootP setting• 

Uses RARP and RIP: Go to"RARP and RIP settinp" 

Uses BootP and RIP: Go to "Entering configuration settings" 

Uses RARP only: Go to "RARP settings" 

Uses BootP only: Go to "BootP settings• 

Uses RIP only: Go to "RIP settings• 

Uses none of them: Go to "Settings when no protocols apply" 

RAllP and BootP setting 

Get this configuration information from your network administrator: 

• What is the default gateway address? -----...--­
Identifies individual networks within a group of interconnected 
networks (an internet) 

Now go to "Entering configuration settings• to put this information into 
the Configuration Panel. 

RAllP and m settlnp 

Get this configuration information from your network administrator: 

• What danain am I in? ------------­
A text version of the IP address. 
Record the name of the domain in the space provided. If you are in two 
domains, see the note below. 

• WhatismyIP~ ------------­
A binary number that identifies a host and the network on which it 
resides. It is inserted in data packets to specify their destination 

+ 1Wo domains: If you must enter two domain names, fmd out which 
domain is the default. Later, when filling out the Configuration Panel, you 
will click the default button for that domain. 
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Now go to "Entering configuration settings• to put this information into 
the Configuration Panel. 

RARP settings 

Get this configuration information from your network administrator: 

• What is the default gateway add~? --------­
Identifies individual networks within a group c:i interconnected 
networks (an internet) 

• What5thea~das.5? ___________ _ 

A code used to identify three classes c:i networks. F.ach class specifies a 
manimum number of hosts permitted 

• What is the subnet mask? -----------­
Bit values set in the IP address to distinguish host addresses from 
subnetwork addresses. By using a subnet mask the network 
administrator can divide a network into smaller subnetworks. 

Now go to "Entering configuration settings• to put this information into 
the Configuration Panel. 

BootP settings 

Get this configuration information from your network administrator: 

• What is the default gateway address? --------­
Identifies individual networks within a group c:i interconnected 
networks (an internet) 

Now go to "Entering configuration settings• to put this information into 
the Configuration Panel. 
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RIP settings 

Get this configuration information from your network administrator: 

• Docs t.bc network use dyaamic addressing? 

Yes: Ask for the following: 
o What are the node range end points?, ________ _ 

Numbers demarcating the range of node numbers associated with an 
IP address. A node is a specialized computer that handles 
communications traffic in a network. 

No: Ask for the following: 

o What is my IP address?------------­
A binary number that identifies a host and the network on which it 
resides. It is inserted in data packets to specify their destination 

o Whatistheaddres.sdass? ___________ _ 
A ccxie used to identify three classes of networks. Each class specifies 
a manimum number of hnsts permitted 

o What is the subnet mask? -----------­
Bit values set in the IP address to distinguish host addresses from 
subnetwork addresses. By using a subnet mask the network 
administrator can divide a network into smaller subnetworks. 

Now go to "Entering configuration settings for networks using RIP or none 
of the protocols• to put this information into the Configuration Panel. 

Settini-' when no protocols apply 

Get this configuration information from your network administrator: 

• Docs the network use dynamic addressing? 

Yes: Ask for the following: 
o What are the node range end points? ________ _ 

Numbers demarcating the range of node numbers associated with an 
IP address. A node is a specialized computer that handles 
communications traffic in a network. 
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No: Ask for the following: 

o What is the default gateway address? --------­
Identifies individual networks within a group of interconnected 
networks (an internet) 

o WhatismylPaddres.s? ____________ _ 

A binary number that identifies a host and the network on which it 
resides. It is inserted in data packets to specify their destination 

o What~ the addres.s class? -------------
A code used to identify three classes of networks. Each class specifies 
a manimum number of hosts permitted 

o What is the subnet mask? -----------­
Bit values set in the IP address to distinguish host addresses from 
subnetwork addresses. By using a subnet mask the network 
administrator can divide a network into smaller subnetworks. 

Now go to "Entering configuration settings for networks using RIP or none 
of the protocols" to put this information into the Configuration Panel. 

Entering configuration settinp 

After obtaining the configuration settings for your type of network, the 
next step is to complete the Configuration Panel depicted in Figure 7-7. If 
your network uses the BootP and RIP protocols or all three protocols(RARP, 
BootP, and RIP), skip step 2; otherwise, perform all the following steps: 
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• F.lpre 7· 7 The MacTCP Configuration Panel 

r--Obta1n Address: -i I IP Address: 
I I I 0 Manually 11 Cless:C!] RddreH: o.o.o.o 

I @> Seruer j I Subnet Meat: 255.255.252.0 

0 Dynamically i 111111111111111111111 iJj 111111111 

I' !;!j:,· Net I SUbnet I Node 
Bits: 8 14 10 

I I Net: lo CJ l.<1< k 

· 1' Subnet: lo ! O Lo< k . rRout1ng lnformat1on:1 -~ ! 
I Gateway Rddress: I Node: lo :1 Oto<k ! 
I t '- -· 

j lo.o.o.o =i 1 jDomaln Name Server Information:-·~ 
1_ • 1 1 Domain IP Rdd[!H Default ! if 44 .. 1190.L0.12 I ® c i 

i L . II Io i l OK J [ Cancel ] lb . ____ J 
1. Click the More button shown at the bottom of Figure 7-6. 

2. find the item or items from the following list for which you 
obtained settinp and follow the related insttuctions. (If your 
network uses IAIP, BootP, and lllP or Just BootP and RIP, skip to 
step 3.) 

o Default gateway address 
Enter this address in the section labeled Routing Information 

o Domain name, IP address, and default button 
Enter this information in the section labeled Domain Name Server 
Information and click the default button. If you enter two domain 
names, click the button for the domain your network administrator 
indicated is the default. 

3. CBck the Server button in the Obtain Address area of the 
Configuration Pand and cBck OK to return to the Control Panel 
(figure 7•6). Close the Control Panel 

4. If your network bas a domain name aemt, restart your 
Madnstosh to activate the cooflguration changes and you're 
ready to go. 
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If your network docs"°' have a domain name server, drag your 
network's Hosts file into your System Folder. Then restart your 
Macintosh and you're finished. 

Your network administrator will explain where to get the Hosts file. If 
no such file exists, you or your network administrator will have to create 
one. (Th~ situation seldom occurs.) See Appendix A in the MacTCP 
AdminiStrator's Guide for instructions. 

S. If you installed and configured MacTCP on a floppy disk, close 
the disk and eject it before going to the next section. 

Now you're ready to install Mac:X, the last step in the installation process. See 
"Installing MacX" at the end of this chapter for instructions. 

Entering configuration settings for networks using RIP or none 
of the protocols 

After obtaining the configuration settings for your type of network, the 
next step is to complete the Configuration Panel depicted in Figure 7-7. 
Follow these steps: 

• Figure 7-7 The MacTCP Configuration Panel 

r-Obtetn Address: ... _ ... _! r-·---.. --·-----IP Address:-·-.. --···--·--·--.. ·--·---, 

l ~O• ~Dey:n:~m;',-'c~lly ;'·,:,',,: i::,i.',,' c1a::L:, 1M::::e;;~.:·:~~;~2.o 
.. .. 111111111111111111111[1111111111 

Net I Subnet I Node 
! l Bits: 8 14 I 0 

; l i 
' · Net· f2~.~~=-~~~-=~~=~J 0 l.oc k 
L.-......................... --···--.. ···----····-·--.. ! i . 

, Subnet: [~~-~~~~-~:~~::~:~~.~:·=:·=.! O I. oc k 
r-Routing lnformet1on:·-1 i -·---·-·---·-··--···-···-· 
l Gateway Address: i l Node: ~--.. -·--·-·--__! 0 I. <H k 1 
I i '---.. -···-···---.. ·----·--·-·--·---···-·-00

··-····-··---·-: i fo:-O~o!i-·---·--··-·---1 i r---·Domein Neme Server lnformetion:·---~ 
L..:::::::::=:::::::::::::=:~....l ! Domein IP Address Default l 

I f"i4a El'° 1.0.12 I ® ~ J 

! L II Io : 
n OK I ( Cencel ) L. ..... --.. ·--... ------··--· ....... ___ ... ·-···----· .. ·---···-.. ·--....... _.....! 
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L Click the More button shown at the bottom of the MacTCP 
Control Pand (Figure 7-6). 

2. Select Manually hi the Obtahl Address area of the Configuration 
Pand Wustratcd hi Figure 7-7. 

3. Find the item or lieois from the following Ust for which you 
obtahlcd settlnp and follow the related Instructions. 

o Default gateway address 
Enter this address in the section labeled Routing Information 

o Domain name, IP address, and default button 
Enter this information in the section labeled Domain Name Server 
Information and click the default button. If you enter two domain 
names, click the button for the domain your network administrator 
indicated is the default. 

o Address class 
Select a class from the pop-up menu in the IP Address area. 

o Subnet mask 
Drag the slider along the address bar until the correct Subnet Mask 
number appears above it. 

4. If your network is 1JOI using dynamic addressing, go to step 6. 

If It is, select the button labeled Dynamically hi the Obtahl 
Address section. 

Two node range fields will appear, as illustrated in Figure 7-8. 
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• Figure 7-8 Entering the node range end.points 

.--Obte1 n Address: .......... 1 

j O Manually I 
I ~ ::::lcelly I 
i Node Range: i l ~:~m: b J 

s. Enter the node range end-point numbers in the boxes Jabeled To 
and From. 

Click OK to return to the Control Panel. Close the Control Panel and go to 

step 8. 

6. Click OK to return to the Control Panel 

7. Enter the IP address for your Macintosh in the IP address field 
shown in Figure 7·9 and close the Control Panel 

8. If your network has a domain name server, restart your 
Macillstosh to activate the configuration changes and you're 
ready to go. 

If your network does not have a domain name server, drag your 
network's Hosts file into your System Folder. Then restart your 
Macintosh and you're fUlished 
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Your network administrator will explain where to get the Hosts file. If 
no such file exists, you or your network administrator will have to create 
one. (This situation seldom occurs.) See Appendix A in the MacTCP 
AdminiStrator's Guide for instructions. 

9. If you installed and configured Mada on a Jtoppy d1sk, dose 
the disk and eject it before going to the next section. 

Now you're ready to install MacX, the last step in the installation process. See 
"Installing MacX" at the end of this chapter for instructions. 

Installing MacX 

Before installing MacX, be sure to install the Communications Toolbox and 
a connection tool first. MacX will not start up without a functioning 
network connection . .MacX will run on a Macintosh with a hard disk drive 
or one with just two floppy drives. 

Follow these instructions to install MacX on a Macintosh with a hard disk. If 
your Macintosh has one floppy disk drive, eject each disk after transferring 
its contents. After installing MacX, you'll be ready to start it up. Consult 
Chapter 2 for instruc.tions on starting and running MacX. 

1. Lock your three MacX disks before inserting them into your 
floppy disk drive. 

Locking the disks ensures that you don't accidentally erase something 
while you are transferring MacX onto your hard disk. The disk is locked 
when you can see through the square hole on the top right side of the 
disk. 

2. Insert the MacX Program disk in your Jtoppy disk drive and 
double-dick the disk icon to open the disk. 

This disk contains the MacX application, a settings document called 
"Sample," and the MacX Colors fde. 
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• Fjgure 7-10 Contents of the MacX Program disk 

3. Drag the MacX application and the Sample document onto the 
dittctory window for your hard disk. 

This folder is also called the Finder directory window. After the Finder has 
copied these fdes onto your hard disk you can move them anywhere on 
your desktop. Create a folder for them if you like. 

4. Drag the MacX Colors file onto your directory window or into 
your System Folder. 

If you put MacX Colors onto your desktop, place it in the same folder as 
your MacX application. If your MacX application isn't in a folder, create 
one and drag MacX and the MacX Fonts folder into it. 

5. Create a new folder on your desktop labeled MacX Fonts or open 
your System Folder and create the MacX Fonts folder there. 

If you create the folder on your desktop, place it in the same folder as 
your MacX application. If your MacX application isn't in a folder, create 
one and drag MacX and the MacX Fonts folder into it. 

6. Insert one of the MacX Fonts disks into your floppy drive. 

If you have just one floppy drive, eject the program disk. 

7. Select all of the fonts in the disk and drag them to the MacX Fonts 
folder. 

8. Insert the other MacX Fonts disk into your floppy drive and 
repeat step 7. 

That's all there is to it! Now you're ready to to start up MacX. 

MacX will run on a Macintosh that has two floppy disk drives instead of a 
hard disk drive. Essentially, you will have to put the System Folder on one 
disk and the MacX application on the other. After installing MacX, you'll be 
ready to start it up. Consult Chapter 2 for instructions on starting and 
running MacX. 

1. Lock your three MacX disks before inserting them into your 
floppy disk drive. 
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Locking the disks ensures that you don't accidentally erase something 
while you are transferring files onto your working pair of floppy disks. 
The disk is locked when you can see through the square hole on the top 
right side of the disk. 

2. Insert the MaCX Program disk into one floppy disk drive and a 
blank disk into the other drive. Double-dick the program disk 
icon to open the disk. 

This disk contains the MacX application, a settings document called 
·sample,. and the MacX Colors me. 

• FJgure 7· 11 Contents of the MacX Program disk 

3. Drag the MacX application and the Sample document onto the 
blank disk. 

Cl~e the blank disk and label it •MacX Disk" or something similar. This 
disk will be the one from which you run MacX. Now eject this disk or 
drag it to the trash and insert another blank disk. 

• FJgure 7-12 Contents of the MacX Disk 

4. Iosert another disk containing a System Folder with version 6.0.2 
or later of the Madntosh operating system. label the disk "MacX 
System Disk" or something similar, if you have not already done 
so, and open the disk. 

You should have created this disk earlier when you installed a connection 
tool. 
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s. Drag the MacX Colors rue from the MacX Program disk into the 
System Folder on the system disk. 

Close the MacX Program disk and drag it to the trash. 

6. Create a new folder in your System Folder labeled •MacX Fonts." 

7. Insert one of the MacX Fonts disks into your floppy drive and 
open the disk. 

8. Find and select the font files labeled "cursor" and "fixed" and 
drag them to the MacX Fonts folder. 

If cursor and fixed aren't on the fonts disk, eject it, insert the other MacX 
Fonts disk and locate these two fonts there. You can also drag other 
fonts into your MacX Fonts folder, but take care not to fill up the disk. 

9. Close the MacX Fonts disk and drag it to the trash. 

The System Folder on your MacX Systems Disk should look something 
like the one illustrated in Figure 7-13. 

• Figure 7-13 Sample System Folder 
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This System Folder shows icons for the MacTCP connection tool. You \.._.,.. 
should have already installed a coMection tool on your system disk by 
following instructions in the related installation section located after the 
section on installing the Comm Toolbox (in this case1 "Installing MacTcP•). 

Once you have installed the Communications Toolbox, a COMection tool, and 
MacX on your two floppy disks you'll be ready to to start up MacX. See 
Chapter 2, •Getting Started1 • for further instructions. 
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Malcolm Versus Other X Servers 

THIS APPENDIX STATES THE DIFFERENCES BE1WEEN MALCOL• &'D CONVENTIONAL x 
servers. 
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Font path searching 

In order to reduce the complexity of handling fonts and maintain a 
Macintooh-like user interface, Malcolm will not search through multiple font 
folders to locate fonts. It ignores font path search requests from clients. 
The only impact on the person using fonts in Malcolm is that all X Fonts 
must be kept in the MacX Fonts folder. 

Typing international characters 
Malcolm confonns to the standard Macintosh method for typing 
international characters, that is, holding down the Option key and pressing 
another character to obtain diacritical marks, such as grave accent ('), 
circumflex("), and tilde(-). For example, on the U.S. keyboard, pressing the 
Option key and the t key together and then typing another letter produces a 
circumflex over that character. Use the Key C.aps desk accessory to see what 
keys to press on your keyboard to obtain these marks. For more 
information, consult your Macintosh System Software User's Gutde. 

Appendix E contains matrices indicating the hexadecimal equivalents for ISO 
Latin 1 and Macintosh Extended ASCII characters. Since these characters do 
not always have the same hexadecimal value when translated from one 
character set to the other, this appendix also contains a map of character-set 
translations. 

Client incompatibilities 

Malcolm handles the requests and clients named in this section differently 
than conventional X servers. 
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An XGetlmage request is like a screen 
snapshot. 

Listing fonts 

Apple Confidential 

Malcolm cannot accurately reproduce some animation requests made by the 
Universal Window Manager (uwm) because it uses an off-screen bit map and 
does not update the screen often enough to reproduce some effects. For 
example, when uwm wants a object to flicker, it issues instructions to draw 
and erase the object in a single X request It sends many such requests to the 
X server, which displays them on the screen. However, Malcolm draws these 
requests on an off-screen bit map and does not update the screen often 
enough to reproduce the flickering there. Consequently, when you try to size 
a new window, for instance, the outline of the window disappears so that 
you can't see how big the window is getting while you move the mouse 
pointer. When you release the middle mouse button (the Left Arrow key on a 
Macintosh keyboard), the window reappears, revealing its size.This problem 
occurs only with uwm in rooted mode. In rootless mode, the Malcolm 
Window Manager takes effect. 

Clients, like :xwd (the X Window Dumper), that request an image of an 
invisible root window using the XGetlmage request will get a white pixmap. 
Essentially, this request produces a blank, white square because, in rootless 
mode, Malcolm cannot capture an image of a root window that isn't visible. 
However, if the XGeUmage request specifies an image of client windows in 
the rootless environment, Malcolm can comply. 

Certain clients, such as xlsfonts, use the XListFonts or XListFontsWithinfo 
requests to list all fonts currently available. In Malcolm, these requests will 
not list Macintash fonts that are not listed in the Font Directory file, with 
one exception. If you are using a Macintosh font that isn't recorded in the 
Font Directory file at the time the client issues one of these requests, that 
font will also be included in the list. Even though you can't list all Macintosh 
fonts available, you can still specify any Macintosh font name in client 
commands for the purpose of displaying text. 
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The Malcohn Window Manager 

THE MALCOLM WINDOW MANAGER co•1110I.S THE APPEARANCE '"'" 

manipulation of windows in rootless mode, extending the Macintosh look 

and feel to the conventional X environment. Appendix B identifies its notable 

features. 
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Transferring text between clients 
In conformance wlh the ICCCM, the Malcolm Window Manager enables you 
to cut, copy, and paste text from one client to another. To transfer text, use 
the client's method to perform the cut, copy, or paste operation. Malcolm is 
advised of a cut or copy event and places the selected text in the clipboard. 
When you indicate where you want to paste this text, by issuing the 
appropriate command within the client you want to receive it, Malcolm will 
transfer the contents of the clipboard to that client. For example, to paste 
your selection in an xterm window, you would press the left arrow key, the 
equivalent in Malcolm to pressing the middle mouse button. 

As discussed in earlier chapters, the Malcolm Window Manager also enables 
you to cut, copy, and paste text from Macintosh applications to clients and 
to copy and paste text, such as font or color names, from Malcolm dialog 
windows (the Remote Command window, Font Director window, and Color 
Namer) to clients using subtantially the same operation. See Chapter 1 for a 
summary of this procedure. 

Appendix B: The .Malcolm Window Manager Apple Confidential 5/30/89 
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T "" APPENDIX CONfAlNS A COPY OF TIJE DOCVME'7' BITMAP DIS11l/BrinON 

Format 2.1, written by Adobe Systems, Inc. It is provided as a reference to 

programmers who want to compile fonts from BDF files. 
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Copyright C 1984, 1987, 1988 Adobe Systems, Inc. 

Permission to use, copy, modify, and disttibute this 
software and its documentation for any purpose and without 

fee is hereby granted, provided that the above copyright 
notice appear in all copies and that both that copyright 
notice and this permission notice appear in supporting 

documentation. 
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1. Introduction 
This document describes Bitmap Distribution Fonnat (BDF), version 2.1. BDF is an X 

Consortium standard for font interchange, intended to be easily understood by both humans and 
computers. 

2. File Format 
Otaracter bitmap information will be distributed in an USASCU encoded, human readable form. 

&ch file is encoded in the printable characters (octal 40 through 176) of USASCU plus carriage 
retmn and linefeed. Each file consists of a sequence of variable-length lines. Each line is 
terminated by a carriage-return (octal 015) and line-feed (octal 012), or by just a line-feed. 

The information about a particular family and face at one size and orientation will be contained 
in one file. The file begins with information pcnaining to the face as a whole, followed by the 
infonnation and bitmaps for the individual characters. 

A font bitmap description file has the following general form, wheie each item is contained on 
a separate line of text in the file. Items on a line are separated by spaces. 

1. The word STARTFONT followed by a version number indicating the exact file 
format used. The version described here is number 2.1. 

2. One or more lines beginning with the word COMMENT. These lines may be ignored 
by any program reading the file. 

3. The word FONT followed by the full name of the font. Note that the name 
continues all the way to the end of the line, and may contain spaces. 

4. The word SIZE followed by the point sb.e of the characters, the JC resolution, and 
the y resolution of the device for which these characters were intended. 

S. The word FONTBOUNDINGBOX followed by the width in JC, height in y, and the x 
and y displacement of the lower left corner from the origin. (Sec the examples in 
section 3). 

6. Optionally the word STARTPROPERTIES followed by the number of properties (p) 
that follow. 

7. Then come p lines consisting of a word for the property name followed by either 
an integer or string surrounded by double-quote (octal 042). Internal double­
quotcs characters are indicated by using two in a row. 

8. Properties named FONT_ASCENT, FONT_DESCENT, and DEFAULT_CHAR should be 
provided to define the logical font-ascent and font-descent and the default-char for 
the foot These properties will be removed from the actual font properties in the 
binary form produced by a compiler. If these properties are not provided, a 
compiler may reject the font, or may compute (arbitrary) values for these 
properties. 

9. The propeny section, if it exists, is terminated by ENDPROPERTIES. 

10. The word CHARS followed by the number of character segments (c) that follow. 

("~~ 11. Then come c character segments of the form: 

Xll BDF Version 2.1 



a,_, Dilttib11don Fo1111111 

L The word STARTCHAR followed by up to 14 chanctcrs (no blanks) of 
descriptive name of the aJyph. 

2 

b. 1be word ENCODING followed by a positive intepr iepn:.senting the Adobe rt-~, 
Standard Encodina value. If the character is not a member of the Adobe 1~ 
Standard Encoding, ENCODING is followed by ·I and ID optional integer 
specifyin1 the aJyph index; if the aJyph index is not specified, a compiler 
will typically ignore the character segment. 

c. The word SWIDTH followed by the scalable width in x and y of chancter. 
Scalable widths are in units of l/lOOOth of the size rA die chamcter. If the 
size of the character is p points, the· width infcrmadoa must be scaJtd by 
p/1000 to pt the width of the character in printer's points. This width 
information should be considered as a vector indicalion die position of the 
next character's origin relative to the origin of this cbancter. To convert 
the scalable width to the width in device pixels. multiply SWID'Ill times 
p/1000 times rn2 where r is the device resolution in pixels per inch. The 
result is a real number giving the ideal print width in device pixels. The 
actual device width must of course be an integral number of device pixels 
and is given in the next entry. The SWIDTH y value sboald always be zero 
for a standard X font. 

d. The word DWIDTH followed by the width in x and y m the character in 
device units. Like the SWJD1ll, this width information is a vector indicating 
the position of the next character's origin relative to die origin of this 
character. The DWIDTH y value should always be zen> for a standard X 
font. 

e. The word BBX followed by the width in x (BBw), heipt in y (BBh) and x 
and y displacement (BBox, BBoy) of the lower left comer &om the orialn 
of the character. 

f. The optional word ATl'RlBUl'ES followed by the attributes as 4 
hex-encoded characters. The interpretation of these ann'butes is undefined 
in this document. 

g. The word BrrMAP. 

h. h lines of hex-encoded bitmap, padded on the ript with zero's to the 
nearest byte (i.e., multiple of 8). 

i. The word ENDCHAR. 

12. The file is terminated with the word ENDFONT. 

3. Metric Information 
Figures 3-1 and 3-2 best illustrate the bitmap format and character mcuic information. 

XU BDF Venioa 2.1 
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~BBox 

< eew> 
•• • •• • •• • •• • 

•• • • •• •• • •• • •• • •• • •• • •• • •• • • •• BBoy1 
BBh 

• • • • • • • • • • • • • • • • • • • • • • • • 

BBw = 9, BBh = 22, BBox = -2, BBoy = -6 
Rounded character width = 8 0 

''+''=character origin and width 

Figure 3-1: An example of a descender 
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--+ BBox 

<saw> 

~I 
•II! • •• • •• • •• •• II! •• 

BBoy + + 

BBh = 6, BBw = 4, BBox = +2, BBoy • + 12 
Rounded character width = S 0 

Jlaure J.2: An example with 1he oripn outside the bounding box 
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4. An Example File 
Figure 4-1 is an abbreviated example of a bitmap file containing the specification of two 

characters (the j and quoteriaht in 3).1 

ftUTl'Cln' 2.1 
COtNEft n..t.• b a Mll!Pl• font iA 2.1 fozm.t. 
J'Oft llel...U.oa-8old 
SID I 200 200 
l'Oll'1'80UMDI.:&OX 9 2• -2 -C 
ftUDROHRTIU 2 
llidpaoe C 
Copyright "Copyript (o) 1H'7 Adobe ly.t ... , lac.• 
IDIDHOPD!'D8 
CDU 2 
ITU'fCIWl j 
DOODIJIG 101 
SWID'f'B 355 0 
DNID'f'B I 0 
BBX 9 22 -2 -C 
BI'NU 
0310 
0310 
0310 
0310 
0000 
0'700 
0'700 
0'700 
0'700 
0&00 
0&00 
0&00 
0&00 
0&00 
1COO 
lCOO 
lCOO 
1COO 
2COO 
'7800 
1'000 
&000 
DIDCBUl 
ITU'l'C:Dlt quotedgbt 
DOODIJIG 39 
SWID'f'B 223 0 
DIJrID'Dl 5 0 
BBXC52U 
A1"1"JlDO'l'U 01CO 
8I'NU 
'70 
'70 
10 
&O 
co 
DDCSU. 
mmron 

Figure 4-1: A shon example file 

1Helvetica~ is a registered lrademark of Allied Corporation. 
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X Logical Font Description 
Conventions 

T ""APPENDIX CONTAJNS A COPY OF THE DOCUMENT, x LOGICAL FONI 

Description Conventions, written by Jim Flowers at Digital Equipment 

Corporation. It is provided as a convenience for those who need to refer to 

the X font name standard. Table 5-1 in Chapter 5 provides a summary of the X 

font name format sufficient for interpreting the font names in the MacX 

Font Director window. 
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X Logical Font Description Conventions 

x Windows System, Version 11 

Draft X Standard Vt.a lor public tevlaw 

Abstract 

It is a requirement that X client applications must be portable across server implementations, with very 
different file systems, naming conventions, and font libraries. However, font access requests, as defined by 
the X Window System Protocol, Version 11t do not specify server-independent conventions for font names, 
nor provide adequate font properties for logically describing typographic fonts. 

Conventions are established which identify fonts via a standard parsable font name and optional font 
properties in a server-independent way, thus providing X clients a mechanism to query and understand 
fonts available on foreign servers. 

Copyright C 1988, 1989 by Digital Equipment Corporation, Maynard MA. 

Permission to use, copy, modify, and distribute this documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice and this permission notice appear in all copies. MIT 
and Digital Equipment Corporation make no representations about the suitability for any purpose of the 
information in this document. This documentation is provided as is without express or implied warranty. This 
document is only a draft standard of the MIT X Consortium and is therefore subject to change. 

Digit.I Equipment Corporation 

t The X Window Syat.em ia a regiat.ered trademark or the Mauachu1etta lditute or Technology. 
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1 Introduction 
It is a requirement that X client applications must be portable across server implementations, 
with very clift'erent file systems, naming conventions, and font libraries. However, font access 
requeata, u defined by the X Window System Protocol, ~rsion 11, do not specify server­
independent conventions for font names, nor provide adequate font properties for logically 
describing typographic fonts. 

X clients moat be able t.o dynamically determine fonts available on any given server, in what 
sizes, styles, etc, so that understandable information can be presented t.o the user, or that 
intelligent font fallbacks can be chosen. It is desirable that the most common queries could 
be accomplished without the overhead of opening each font and inspection of font properties, 
i.e. through simple ListFonts requests (e.g. if a user selected a Helveticat typeface family, a 
client application should be able t.o query the server for all Helvetica fonts and present only 
those setwidths, weights, slants, point sizes, character sets available for that family). 

This document gives a standard logical font description (XLFD) and conventions t.o be used in 
the X protocol so that clients can query and access screen type libraries in a consistent manner 
across all X servers. In addition t.o completely specifying a given font via its FontName, the 
XLFD also provides for a standard set of key FontProperties that describe the font in more 
detail. 

XLFD provides an adequate set of typographic font properties, such as CAP _HEIGHT, X_ 
HEIGHT, RELATIVE_SETWIDTH, for publishing and other applications to do intelligent 
font matching or substitution when handling documents created on some foreign server 
using potentially unknown fonts. In addition, this information is required by certain clients 
t.o aut.omatically place subscripts, determine small capital heights, recommended leading, 
wordspace values, etc. 

Examples are for illustrative purposes only. 

2 Requirements and goals 
This specification meets the short and long-term goals t.o have a standard logical font 
description which: 

• provides unique, descriptive font names that support simple pattern matching; 

• supports multiple font vendors, arbitrary character sets & encodings; 

• is X server & operating/file system independent; 

• provides adequate descriptive font information for arbitrarily complex font match­
ing/substitution; 

• is extensible. 

t See 'fypefact Copyriglata aec:tion for copyright information 
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2.1 Unique, descriptive font names 
It should be pouible to have font names that are long enough and descriptive enough to have 
a reasonable probability of being unique without inventing a new registration organization. 
Resolution/size-dependent font masters, multi-vendor font libraries, etc, must be anticipated 
and handled by the font name alone. 

The name itself should be structured to be amenable to simple pattem matching and parsing, 
allowing X clients to restrict font queries to some subset of all possible fonts in the server. 

2.2 Support multiple vendors and character sets 
The font name and properties should distinguish between fonts that were supplied by different 
font vendors, but possibly sharing the same name. We anticipate a highly competitive font 
market where users will be able to buy fonts from a number of sources according to their 
particular requirements. 

A number of font vendors deliver each font with all glyphs designed for that font, where 
charset mappings are defined by encoding vectors. Certain server implementations may force 
these mappings to proprietary or standard charsets statically in the font data, while others 
may desire to perform the mapping dynamically in the server. Provisions must be made in 
the font name which allows a font request to specify/identify specific charset mappings in 
server environments where multiple charsets are supported. 

2.3 Server, operating and file system Independent 
X client applications that require a particular font should be able to use the descriptive name, 
without knowledge of the file system or other repository in use by the server. However, 
it should be possible for servers to translate a given font name into a file name syntax 
that it knows how .to deal with, without compromising the uniqueness of the font name. 
This algorithm should be reversible (exactly how this translation is done is implementation 
dependent). 

2.4 Supports arbitrarily complex font matching/substitution 
In addition to the font name, the XLFD should define a standard list of descriptive font 
properties with agreed upon fallbacks for all fonts, so that client applications can derive font· 
specific formatting/display data, perform font matching/substitution when asked to handle 
potentially unknown fonts, as required. 

2.5 Extensible 
The XLFD must be extensible so that new and/or private descriptive font properties can be 
added to conforminc fonts without obsoleting existing X client or server implementations. 

3 X Logical Font Description 

2 

XLFD i1 divided into two basic components, the FontName, which gives all font information 
needed to uniquely identify a font in X protocol requests (OpenFont, ListFonts, etc), and a 
variable liat of optional FontPropertlea that describe a font in more detail. 

,('''"',\ 

\~_) 



c, 

The FontName is used in font queries and returned as data in certain X protocol requests. 
The FontName is also specified as the data value for the FONT item in the X Consortium 
Charact.er Bitmap Distribution Format specification CBDF V2. l). 

The FontProperties are supplied on a font-by-font basis, and are returned as data in certain 
X protocol requests as part of the XFontStruct data structure. The Font.Property names 
and their associated data values may also appear as items of the STARTPROPERTIES -
ENDPROPERTIES list in the BDF 2.1 specification. 

3.1 FontName 
The FontName is logically composed of two strings, a FontNameReliatry prefix, followed 
by a FontNameSuftlz. The FontNameRegistry is a %·registered-name that identifies the 
registration authority that owns the specified FontNameSuffix syntax and semantics. 

All font names conforming to this specification will use a FontNameRegistry prefix defined to 
be the string•.•, i.e. ISO 8859-1 HYPHEN (Column/Row 02/13). All FontNameRegistry pre­
fixes of the form •+version-·. where version is the version of some future XLFD specification, 
are reserved by the X Consortium for future extensions to XLFD font names. If required. 
extensions to the current XLFD font name shall be constructed by appending new fields to 
the current structure, each delimited by the existing field delimiter. The availability of other 
FontNameRegistry prefixes or fonts supporting other registries is server implementation de­
pendent. 

In the X protocol specification, the FontName is required to be a string, hence numeric field 
values are represented in the name as string equivalents. All FontNameSuffix fields are also 
defined as Font.Properties, in which case numeric property values are represented as signed 
or unsigned integers as appropriate. 

3.1.1 FontName Syntax 

The FontName is a structured, parsable string (X data type STRINGS), whose Backus-Naur 
Form syntax description is as follows: 

Table 1: FontName Syntax 

FontName ::• XFontNameRegistry XFontNameSuffix I PrivFontNameRegistry 
PrivFontNameSuffix 

XFontNameRegistry ::• Delim I XFNExtPrefix Version XFNDelim 

XFontNameSuffix ::• FOUNDRY XFNDelim FAMll.Y_NAME XFNDelim WEIGHT_NAME 
XFNDelim SLANT XFNDelim SETWID'nl_NAME XFNDelim ADD_ 
STYLE_NAME XFNDelim PIXEL_SIZE XFNDelim POINT_SIZE 
XFNDelim RESOLUTION_x XFNDelim RESOLUTION_Y XFNDelim 
SPACING XFNDelim AVERAGE_ WIDTH XFNDelim CHARSET_ 
REGISTRY XFNDelim CHARSET_ENCODING 

Version ::- STRIN~the XLFD version defining an ext.ension to font name syntax, 
•·•· •1.s· 

XFNExtPreflz ::• OCTET-the value of 1808859-1 PLUS (Column/Row 07113) 
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Tebfe 1 (Cont.): FontName Syntax 

D'NDellm ::• OCTET-the value of IS088S9·1 HYPHEN (Column/Row 02113) 

PrivPcmNameRqistry STRINGS-other than thoee atrinp reserved by XI.FD 
::• 

PrivFontNameSufftx ::• STRINGS 

Field values are constructed as strings of 1808859· 1 graphic characters, excluding the 
following: 

• HYPHEN (02/13), the XLFD font name delimiter character; 

• QUESTION MARK (03/15) and ASTERISK (02110). the X protocol fontname wildcard 
characters; 

Alphabetic case distinctions are aUowed, but are for hum.an readability concerns only. 
Conforming X servers will perform matching on font name query/open requests independent of 
case. The entire font name string must have no more than 255 characters. It is recommended 
that clients construct font name query pattem1 by explicitly including all field delimiters to 
avoid unexpected results. Note, that SPACE is a valid character of a FontName field, e.g. a 
FAMILY_NAME might be ITC Avant Garde Gothic. 

3.1.2 FontName Fleld Deflnttlons 

3.1.2.1 FOUNDRY X•f'lglster«J.name 

FOUNDRY i1 a %-registered-name, the name or identifier of the digital type foundry that 
digitized and supplied the font data, or if different, the identifier of the organization that last 
modified the font shape or metric information. 

The reason this di1tinction is necessary is that a given font desip may be licensed from one 
source (e.1. ITC), but digitized and sold by any number of different type suppliers. Each 
diiital version of the original design will in general be somewhat different in metrics and 
shape from the "idealized" original font data, as each font foundry-for better or for worse­
has its own standards and practices for tweaking a typeface for a particular generation of 
output technologies, or its own perception of market needs. 

It is up to the type supplier to register with the X Consortium a suitable name for this 
FontName field, according to the registration procedures defined by the Consortium. 

The X Consortium shall define procedures for registering foundry names, and shall maintain 
and publish in a timely manner a registry of such registered names for use in XLFD font 
names and properties. 

3.1.2.2 FA&V_NAME •ring 
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FAMILY_N.AME is a 1trirw that identifies the range or "family" of typeface designs that are 
all varilliona of one basic typographic style. This must be apelled out in full, with words 
separated by spaces as required. This name must be human-understandable and suitable for 
presentation to a font user to identify the typeface family. 
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It is up to the type supplier to supply and maintain a suitable string for this field and 
font property, to eecure the proper legal title to a given name, and to guard against the 
infrinpment of other'• copyrights or trademarks. By convention, FAMILY_NAME is not 
translated. FAMILY_NAME may include an indication of design ownership if considered a 
valid part of the typeface family name (see examples below). 

Examples of FAMILY_NAMEs: 

Helveticat 
ITC Avant Garde Gothic 
Times 
Times Roman 
Bitstream Amerigo 
Stone 

.3.1.2.3 WEIGHT_NAME string 

WEIGHT_NAME is a stri716 that identifies the font's typographic weight, i.e. the nominal 
blackness of the font, according to the FOUNDRY's judgement. This name must be human­
understandable and suitable for presentation to a font user. 

The interpretation of this field is somewhat problematic, as the typographic judgement of 
weight has traditionally depended upon the overall design of the typeface family in question . 
(i.e. it is possible that the DemiBold weight of one font could be almost equivalent in 
typographic feel to a Bold font from another family. 

WEIGHT_NAME is captured as an arbitrary string since it is an important part of a 
font's complete human-understandable name, but it should not be used for font match­
ing/substitution. X client applications should use the weight-related font properties (RELA­
TIVE_ WEIGHT&: WEIGHT) which give the coded relative weight, and the calculated weight, 
respectively, for this purpose. 

3.1.2.4 SLANT code-string 

SLANT is a code-string that indicates the overall posture of the typeface design used in the 
font. 

The encoding is as follows: 

Table 2: SLANT encoctlngs 

Code En1liah Strini Description 

"'R. Roman - upright design 

·r Italic - italic design, slanted clockwise from vertical 

·o- Oblique - obliqued upright design, slanted clockwise from vertical 

"RI'" Reverse Italic - italic design, slanted counter clockwiae from vertical 

t See 'IYpefOl!e Copyn,hte section for copyright information 
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Table 2 (Cont.): SLANT encodings 

R8vene Oblique 

Other 

- obliqued upright design, alant.ed count.er clockwise from 
vertical 

-other 

The SLANT codes are for programming convenience only, and usually are converted into their 
equivalent human-understandable form before being present.ed to a user. 

3.1.2.5 SETWIDTH_NAME string 

SETWIDTH_NAME is a string that gives the foni-s typographic proportionate width, i.e. the 
nominal width per horizontal unit of the font, according to the FOUNDRY'• judgment. 

Aa with WEIGHT_NAME, the interpretation of this field or font property is somewhat 
problematic, as the designer's judgment of aetwidth has traditionally depended upon the 
overall design of the typeface family in question. X client applications ahould use the 
RELATIVE_SETWIDTH font property which gives the relative coded proportionate width, 
or calculate the proportionate width, for purposes of font matching or substitution. 

Examples of SETWIDTH_NAMEs: 

Normal 
Condensed 
Narrow 
Double Wide 

3.1.2.fS ADD_STYLE_NAME string 

ADD_STYLE_NAME is a string that identifies additional typographic style information not 
captured by other fields, but needed to uniquely identify the font. 

ADD_STYLE_NAME is not a typeface classification field, and is only used for uniqueness. 
Its usage, as such, is not limited to typographic style distinctions. 

Examples of ADD_STYLE_NAMEs: 

Serif 
Sans Serif 
Informal 
Decorated 

3.1.2.7 PIXEL_SIZE ln•r·strlng 
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PIXELJDZE is an unsigned inte,er-string typographic metric in device pixels which gives 
the b9cJ, size of the font at a particular POINT_SIZE and RESOLUTION_Y. PlXEL_SIZE 
normaJJt incorporates additional vertical spacing considered part of the font design (note, 
however, that this value is not necessarily equivalent to the height of the font bounding box). 
PIXEL_SIZE is in the range 0 to a •very-large-numbe'I"'. 

~,' 
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PIXEL_SIZE would normally be used by X client applications that need to query fonts 
according to device-dependent size, regardless of the point size or vertical resolution the font 
was de1iped for. 

3.1.2.8 POINT _SIZE lntll{ler-strlng 

POINT_SIZE is an unsigned integer-string typogTaphic metric in device-independent units 
which gives the body size the font was designed for. This field normally incorporates additional 
vertical spacing considered part of the font design (note, however, that POINT_SIZE is not 
necessarily equivalent to the height of the font bounding box). POINT_SIZE is expressed in 
decipoints (where points are as defined in the X protocol, or 72.27 pts = 1 inch) in the range 
0 to a •very-large-number". 

POINT_SIZE and RESOLUTION_Y would be used by X clients to query fonts according to 
device-in<Upendent size, to maintain constant text size on the display regardless of the PIXEL_ 
SIZE used for the font. 

3.1.2.9 RESOLUTION_X Integer-string 

3.1.2.10 RESOLUTION_ Y lntll{ler·strlng 

RESOLUTION_X & RESOLUTION_Y are unsigned integer-strings, the horizontal and ver­
tical resolution that the font was designed for, measured in pixels/dots per inch (dpi). Hor­
izontal and vertical values are required since a separate bitmap font must be designed for 
displays with very different aspect ratios, e.g. 1:1, 4:3, 2:1, etc. 

The separation of pixeVpoint size and resolution is necessary because X allows for servers 
with very different video characteristics (horizontal and vertical resolution, screen and pixel 
size, pixel shape, etc.) to potentially access the same font library. The font name, then, must 
differentiate between a 14 point font designed for 75 dpi (body size of about 14 pixels) or a 
14 point font designed for 150 dpi (about 28 pixels), etc. Further, in servers that implement 
some or all fonts as continuously scaled outlines, POINT_SIZE and RESOLUTION_Y will 
help the server to differentiate between potentially separate font masters for text, title and 
display sizes or for other typographic considerations. 

3.1.2.11 SPACING code-string 

SPACING is a code-string that indicates the escapement class of the font, i.e. monospace (fixed 
pitch), proportional (variable pitch), or charcell (a special monospaced font that conforms to 
the traditional data processing character cell font model). 

Table 3: SPACING encodings 

Code En1liah Strini 

Proportional 

Monospace 

Description 

- a font whose logical character widths vary for each glyph. 
Note that no other restrictions are placed on the metrics of a 
proportional font; 

- a font whoee logical character widths are constant (i.e. all 
char widths of the font are • max_bounds.width). No other 
restrictions are placed on the metrics of a monospaced font; 
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Table 3 (Cont.): SPACING encodings 

Cocle 

.C" CharCell 

Deecription 

- a monoepaced font which follows the standard typewriter 
character cell model, i.e. the glyphs of the font can be modeled 
by X clients u "'boxes• of the 181De width and height which 
are imaged llide by aide to form text strings, or top to bottom 
to form text lines. By definition, all glyphs have the same 
logical character width, and no Jlypha have "ink" outside oC the 
character cell-there ia no kerning (i.e., on a per char basis with 
positive metrics: 0 <• lef\-bearing <• right-bearing <• width; 
with negative metrics: width<• lef\..bearing <•right-bearing 
<• 0)-and the vertical extents oC the font do not exceed the 
vertical spacing (i.e. on a per char basis: aacent <• font-ascent 
& descent <• font-deaeent). The cell height • font-descent + 
font-ascent, and width • AVERAGE_ WIDTH. 

3.1.2.12 AVERAGE_WIDTH Integer-string 

AVERA.GE_WIDTH is an unsigned integer-string typographic metric value giving the un· 
weighted arithmetic mean width of all glyphs in the font, measured in l/lOth pixels. Note, 
for monospaced and character cell fonts, this is the width of all glyphs in the font. 

3.1.2.13 CHARSET _REGISTRY x-reglstered-name 

3.1.2.14 CHARSET _ENCODING registered-name 
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The character set used to encode the glyphs of the font (and implicitly the font's glyph 
repertoire), as maintained by the X Consortium character set registry. CHARSET_REGISTRY 
is a %·registered-name that identifies the registration authority that owns the specified 
encoding. CHARSET_ENCODING is a registered-name that identifies the coded character 
set as defined by that registration authority. 

Although the X protocol does not explicitly have any knowledge about character set encodings, 
it is expected that server implementers will prefer to embed knowledge of certain proprietary 
or industry standard charsets into their font library for reasons of performance and conve­
nience. The CHARSET_REGISTRY and CHARSET_ENCODING fields/properties allow a X 
client font request to specify a specific charset mapping in server environments where multi­
ple charsets are supported. The availability of any particular character set is font and server 
implementation dependent. 

The X Consortium shall define procedures for registering character set names and shall 
maintain and publish in a timely manner a registry of such registered names for use in 
X protocol font names and properties as specified in XLFD 

The ISO Latin l character set shall be registered by the X Consortium as the CHARSET _ 
REGISTRY-CHARSET_ENCODING value pair: "1808859·1·. 



( 
3.1.3 Example8 

The following examples of font names are derived from the screen fonts shipped with the R3 
server. 

Table 4: Examples of X Font Names 

Font 

Courier 8pt 075dpi 

Courier lOpt 

Courier 12pt 

Courier 14pt 

Courier 18pt 

Courier 24pt 

Courier Bold lOpt 

Courier BoldOblique 
lOpt 

Courier Oblique lOpt 

nmee Roman lOpt 
OlOOdpi 

nmes Bold lOpt 

nmes Boldltalic lOpt 

XFontName 

-Adobe-Courier-Medium-R-N onnal--8-80-75-75-M-50-IS08859-1 

-Adobe-Courier-Medium-R-Normal--10-100-75-75-M-60-IS08859-1 

-Adobe-Courier-Medium-R-Normal--12-120-75-75-M· 70-IS08859-1 

-Adobe-Courier-Medium-R-Narmal--14-140-75-75-M-90-IS08859-1 

-Adobe-Courier-Medium-R-Nonnal--18-180-75-75-M-110-IS08859-1 

-Adobe-Courier-Medium-R-Normal--24-240-75-75-M-150-IS08859-1 

-Adobe-Courier-Bold-R-N ormal--10-100-75-75-M -60-IS08859-1 

-Adobe-Courier-Bold-O-Normal--10-100-75-75-M-60-IS08859-l 

-Adobe-Courier-Medium-O-Normal--10-100-75-75-M-60-IS08859-1 

-Adobe-Times-Medium-R-Normal--14-100-100-100-P-74-IS08859-1 

-Adobe-nmes-Bold-R-Normal--14-100-100-100-P-76-IS08859-1 

-Adobe-nmes-Bold-1-Normal--14-100-100-100-P-77-IS08859-1 

nmes Italic !Opt -Adobe-nmes-Medium-I-Normal--14-100-100-100-P-73-IS08859-1 

Charter 12pt @75dpi -Bitstream-Charter-Medium-R-Normal--12-120-75-75-P-68-IS08859-1 

Charter Boldltalic 12pt -Bitstream-Charter-Bold-I-Normal--12-120-75-75-P-75-IS08859·1 

Charter Bold 12pt -Bitstream-Charter-Bold-R-Normal--12-120-75-75-P-76-IS08859-1 

Charter Italic 12pt -Bitstream-Charter-Medium-I-Normal--12-120-75-75-P-66-1808859-1 

SYMBOL 8pt OlOOdpi -Adobe-Symbol-Medium-R-Normal--11-80-100-100-P-61-Adobe-
FONTSPECIFIC 

Symbol lOpt -Adobe-Symbol-Medium-R-Normal--14-100-100-100-P-85-Adobe-
FONTSPECIFIC 

Symbol 12pt -Adobe-Symbol-Medium-R-Normal··l 7-120-100·100-P-95-Adobe· 
FONTSPECIFIC 
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Table 4 (COnt.): lxlmplM of x Font Names 

Jl'ont 

Symbol 14pt 

Symbol 18pt 

Symbol 24pt 

I'. Jl'ontNuae 

..Adobe-Symbol·Medium-R-Nonnal-·20-140-100-100-P-107-Adobe­
PONTSPECIFIC 

·Adabe.Symbol·Medium-R-Normal--25-180-100-100-P-142-Adobe­
PONTSPECIFIC 

-Adobe-Symbol-Medium-R-Normal--34-240-100-100-P-191-Adobe­
PONTSPECIPIC 

3.2 FontPropertles 
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All font propertiea are optional, but will pnerally include the font name fields, and on a font­
by-font basis any other useful font de1criptivelusage information that may be required to use 
the font intelligently. The XLFD specifies an extensive set of standard X font properties, their 
interpretation and fallback rules when the property is not defined for a given font. The goal 
ia to provide client applications with enough font information to be able to make automatic 
formatting/display decisions with good typographic results. 

Additional standard X font property definitions may be defined, in the future and private 
properties may exist in X fonts at any time. Private font properties should be defined to 
conform to the general mechanism defined in the X protocol to prevent overlap of name space 
and ambiguous property names, i.e. private font property names are of the form: 1808859-1 
UNDERSCORE (Column/Row 05/15), followed by the organizational identifier, followed by 
UNDERSCORE, and terminated with the property name. 

The Backus-Naur Form syntax description ofX Font Properties is given below: 

Table 5: x FontPropertles Syntax 

Properties ::• 

OptFontPropList ::• 

OptFontProp ::• 

PrivateFontProp ::• 

OptFontPropList 

NULL I OptFontProp OptFontPropList 

PrivateFontProp I XFontProp 

STRINGS I Underscore Organizationld Underscore STRINGS 

If"'' 
\lj 
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Table 5 (Cont.): X FontPropertles Syntax 

XFont.Prop ::• FOUNDRY I FAMILY_NAME I WEIGHT_NAME I SLANT I 
SE'IWIDTH_NAME I ADD_STYLE_NAME I PIXEL_SIZE I 
POINT_SIZE I RESOLUTION_x I RESOLUTION_Y I SPACING 
I AVERAGE_WIDTH I CHARSET_REGISTRY I CHARSET_ 
ENCODING I QUAD_WIDTH I RESOLUTION I MIN_BPACE I 
NORM_SPACE I MAX_SPACE I END_SPACE I SUPE~CRIPT_x I 
SUPE~CRIPT_Y I SUBSCRIPT_X I SUBSCRIPr_Y I UNDERLINE_ 
POSITION I UNDERLINE_THICKNESS I STRIKEOUT_ASCENT I 
STRIKEOUT_DESCENT I ITALJC_ANGLE I X_HEIGHT I WEIGHT 
I FACE_NAME I COPYRIGHT I AVG_CAPITAL_ WIDTH I AVG_ 
LOWERCASE_ WIDTH I RELATIVE_SETWIDTH I RELATIVE_ 
WEIGHT I CAP _HEIGHT I SUPERSCRIPT_SIZE I FIGURE_ 
WIDTH I SUBSCRIPT_SIZE I SMALL_CAP_SIZE I NOTICE I 
DESTINATION 

Underscore ::• OCTET-the value of IS08859-1 UNDERSCORE character (Column/Row 
05115) 

Organizationld ::• STRINGS-the registered name of the organization 

3.2.1 FOUNDRY ATOM 

AB defined in the FontN ame, except the property type is ATOM. 

FOUNDRY can not be calculated or defaulted if not supplied as a font property. 

3.2.2 FAMILY_NAME ATOM 

AB defined in the FontName, except the property type is ATOM. 

FAMILY_NAME can not be calculated or defaulted if not supplied as a font property. 

3.2.3 WEIGHT _NAME ATOM 

AB defined in the FontName, except the property type is ATOM. 

WEIGHT_NAME can be defaulted if not supplied as a font property, as follows: 

if (WEIGHT_NAME undefined) then 
WE!GHT_NAME • ATOM ("Medium") 

3.2.4 SLANT ATOM 

As defined in the FontName, except the property type is ATOM. 

SLANT can be defaulted if not supplied as a font property, as follows: 

if (SLANT undefined) then 
SLANT • ATOM("R") 
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3.2.5 SETWIOTH_NAME ATOM 

As defined in the FontName, except the property type is ATOM. 
SETWIDTH_NAME can be def'aulted if not supplied as a font property, as follows: 

i! (S!TWIDTH NAME undefined) then 
SETWIDTH_NAME • ATOM("Normal") 

3.2.6 AOD_STYLE_NAME ATOM 

As defined in the FontName, except the property type is ATOM. 

ADD_BTYLE_NAME can be def'aulted if not supplied as a font property, as follows: 

if (AOC STYLE NAME undefined) then 
AOO_STYLE_NAME • ATOM("") 

3.2. 7 PIXEL_ SIZE CARD32 

As defined in the FontName, except the property type is CARD32. 

X clients requiring pixel values for the various typographic fized spaces CEM space, EN space 
and THIN space), can use the following algorithm for computing these values from other 
properties specified for a font: 

OeciPointsPerinch • 722.7 
EMspace •CEIL ((RESOLUTION X * POINT_SIZE) I OeciPointsPerinch) 
ENspace • CEIL (EMspace I 2) 
THINspace • CEIL (EMspace I 3) 

where •r denotes real division, .. ,, denotes real multiplication and •CEIL" denotes a function 
that rounds its real argument up to an integer. 

PJXEL_SIQ can be approximated if not supplied as a font property, according to the 
algorithm: 

DeciPointsPerinch • 722.7 
if (PIXEL SIZE undefined) then 

PIXEL_SIZE •CEIL ((RESOLUTION_Y * POINT_SIZE) I DeciPointsPerinch) 

3.2.8 POINT_SIZE CARD32 

12 

As defined in the FontN ame, except the property type is CARD32. 

X clients requiring d.evice.independ.ent values for EMspace, ENspace and THIN space, can use 
the following algorithm: 

EMspace - CEIL (POINT_SIZE I 10) 
ENspace • CEIL (POINT SIZE I 20) 
THINspace • CEIL (POINT SIZE I 30) 

Deaip POINT_SIZE can not be calculated or approximated. 



3.2.9 RESOLUTION_X CARD32 

As defined in the FontName, except the property type is CARD32. 

RESOLUTION_x cannot be calculated or approximated. 

3.2.10 RESOLUTION_ Y CARD32 

As defined in the FontName, except the property type is CARD32. 

RESOLUTION_x cannot be calculated or approximated. 

3.2.11 SPACING ATOM 

As defined in the FontName, except the property type is ATOM. 

SPACING can be calculated if not supplied as a font property, according to the definitions 
given above for the FontName. 

3.2.12 AVERAGE_WIDTH CARD32 

As defined in the FontName, except the property type is CARD32. 

AVERAGE_ WIDTH can be calculated if not provided as a font property, according to the 
algorithm: 

if (AVERAGE WIDTH undefined) then 
AVERAGE_WIDTH • CEIL (MEAN (all glyph widths in font) * 10) 

where MEAN is a function that retums the arithmetic mean of its arguments. 

X clients requiring values for the number of characters per inch (pitch) of a monospaced font, 
can use the following algorithm using the AVERAGE_ WIDTH and RESOLUTION.JC, font 
properties: 

if (SPACING not proportional) then 
CharPitch • (RESOLUTION_X * 10) I AVERAGE_WIDTH 

3.2.13 CHARSET_REGISTRY ATOM 

As defined in the FontName, except the property type is ATOM. 

CHA.RSET_REGISTRY can not be defaulted if not supplied as a font property. 

3.2.14 CHARSET_ENCODING ATOM 

As defined in the FontName, except the property type is ATOM. 

CHA.RSET_ENCODING can not be defaulted if not supplied as a font property. 
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3.2.15 MIN_SPACE CARD32 
,4";,,' 

MIN_SPACE is an unsigned integer that gives the recommended minimum wordspace value \ 
to be med with this font. ~· 

MIN_SPACE can be approximated if not provided as a font property, according to the 
algorithm: 

if (MIN_SPACE undefined) then 
MIN_SPACE • CEIL(0.75 * NORM_SPACE) 

3.2.18 NOAM_SPACE CARD32 

NORM_SPACE is an unsigned integer value that gives the recommended normal wordspace 
value to be used with thi1 font. 

NORM_SPACE can be approximated if not provided as a font property, according to the 
algorithm: 

DeciPointsPerinch • 722.7 
if (NORM SPACE undefined) then 

if (SPACE glyph exists) then 
NORM SPACE • width of SPACE 

else NORM SPACE• CEIL((0.33 *RESOLUTION X *POINT SIZE) 
- I DeciPointsPer!nch) -

3.2.17 MAX_SPACE CARD32 

MAX_SPACE is an unsigned integer value that gives the recommended maximum wordspace 
value to be used with this font. 

MAX_SPACE can be approximated if not provided as a font property, according to the 
algorithm: 

if (MAX SPACE undefined) then 
MAX_SPACE • CEIL(l.5 * NORM_SPACE) 

3.2.18 END_SPACE CARD32 

END_SPACE is an unsigned integer value that gives the recommended spacing at the end of 
sentences. 

END_SPACE can be approximated if not provided as a font property, according to the 
algorithm: 

if (END SPACE undefined) then 
END_SPACE • NORM_SPACE 

3.2.19 AVQ_CAPITAL_WIDTH IN132 
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AVG_CAPITAL_ WIDTH i1 an imeger value that gives the unweighted arithmetic mean width 
of all the capital glyphs in the font, in 1/lOth pixels (applies to latin and non-latin fonts). For 
latin fonts, capitals are the glyphs A-Z. Normally used for font matchin~substitution. 

if~"'\ 
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AVG_ CAPITAL_ WIDTH can be calculated if not provided as a font property, according to the 
algorithm: 

if (AVG CAPITAL WIDTH undefined) then 
AVG_CAPITAL_WIDTH • CEIL (MEAN (capital glyph widths) * 10) 

where MEAN is a function that returns the arithmetic mean of its arguments. 

3.2.20 AVG_LOWEACASE_WIDTH INT32 

AVG_LOWERCASE_ WIDTH is an integer value that gives the unweighted arithmetic mean 
width of all the lower case glyphs in the font in lllOth pixels. For latin fonts, lower case are 
the glyphs a-z. Normally used for font matching/substitution. 

Where appropriate, AVG_LOWERCASE_ WIDTH can be approximated if not provided as a 
font property, according to the algorithm: 

if (AVG LOWERCASE WIDTH undefined) then 
if (lower case exists) then 

AVG LOWERCASE WIDTH • CEIL (MEAN (lower case glyph widths) * 10) 
else AVG LOWERCASE WIDTH undefined - -

3.2.21 QUAD_WIDTH INT32 (DEPRECATED) 

QUAD_WIDTH was incorrectly defined in the X protocol, and is redundant since all typo­
graphic fixed spaces (EM, EN & THIN) are constant for a given font size (i.e. they do not 
vary according to setwidth). X clients requiring these properties are encouraged to discon­
tinue usage of QUAD_ WIDTH and compute these values from other font properties. X clients 
requiring a font-dependent width value should use either the FIGURE_ WIDTH or one of 
the average character width font properties (AVERAGE_ WIDTH, AVG_CAPITAL_WIDTH or 
AVG_LOWERCASE_ WIDTH) for this purpose. 

See also PIXEL_SIZE, FIGURE_ WIDTH, AVERAGE_ WIDTH, AVG_CAPITAL_ WIDTH and 
AVG_LOWERCASE_ WIDTH font property definitions. 

3.2.22 FIGURE_ WIDTH INT32 

FIGURE_ WIDTH is an integer typographic metric that gives the width of the tabular figures 
and the dollar sign, if suitable for tabular setting (all widths equal). For latin fonts, these 
tabular figures are the arabic numerals 0-9. 

FIGURE_ WIDTH can be approximated if not supplied as a font property, according to the 
algorithm: 

if (numerals and DOLLAR sign are defined & widths are equal) then 
FIGURE WIDTH • width of DOLLAR 

else FIGORE_WIOTH property undefined 
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3.2.23 SUPEASCRIPT_X INT32 

SUPBBSCIUPT..X i1 an integer value that gives the recommended horizontal offset in r'\. 
pixels hm the position point to the X origin of synthetic superscript text. If the current \"_,/ 
position point is at CX. Y], then superscripts should begin at lX + SUPERSCRIPT _x, Y -
SUPBBSCIUPT_YJ. 

SUPEBSCRIPI'..X can be approximated, if not provided as a font property, according to the 
algorithm: 

if (SUPERSCRIPT X undefined) then 
if CTANGENTCITALIC ANGLE) defined) then 

SUPERSCRIPT X • CEIL((0.40 *CAP HEIGHT) I TANGENTCITALIC ANGLE)) 
else SUPERSCRIPT_X • CEIL(0.40 * CAP_HEIGHT) -

where TANGENT i1 a trigonometric fUnction that returns the tanpnt of its argument (in 
degrees 1caled by 64). · 

3.2.24 SUPEASCRIPT_ Y INT32 

SUPERSCRIPT_ Y is an integer value that gives the recommended vertical off1et in pixels from 
the position point to the Y origin of synthetic superscript text. If the current position point is 
at [X,Y], then superscripts should begin at [X + SUPERSCRIPT..X, Y - SUPERSCRIPT_Y]. 

SUPERSCRIPT_Y can be approximated, if not provided u a font property, according to the 
algorithm: 

if (SUPERSCRIPT Y undefined) then 
SUPERSCRIPT_Y-• CEIL(0.40 * CAP_HEIGHT) 

3.2.25 SUBSCRIPT _X INT32 

SUBSCRIPl'_x is an integer value that gives the recommended horizontal oft'tet in pixels 
from the position point to the X origin of synthetic subscript text. If' the current position 
point is at [X,Y], then subscripts should begin at [X + SUBSCIUPT..X, Y + SUBSCRIPl'_Y]. 

SUBSCRIPT_x can be approximated, if not provided as a font property, according to the 
algorithm: 

if (SUBSCRIPT X undefined) then 
if (TANGENT(ITALIC ANGLE) defined) then 

SUBSCRIPT X • CEIL( (0.40 * CAP. HEIGHT) I TANGENT(ITALIC ANGLE)) 
else SUBSCRlPT_X • CEIL(0.40 * CAP_HEIGHT) -

3.2.28 SUBSCRIPT_ Y INT32 
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SUBSCRIPT_Yi1 an integer value that gives the recommended vertical offset in pixels·from 
the potit.ion point to the Y origin of synthetic subscript text. If the current pOsition point is 
at CX.YJ. then subscripts should beein at [X + SUBSCRIPl'..X, Y + SUBSCRIPI'_Y]. 

SUBSCBIPl'_Y can be approximated, if not provided u a font property. according to the 
algorithm: 

if (SUBSCRIPT Y undefined) then 
SOBSCRIPT_Y-• CEIL(0.40 * CAP_HEIGHT) 
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3.2.27 SUPERSCRIPT_SIZE CARD32 

SUPERSCRIPr_SIZE is an unsigned integer value that gives the recommended body size of 
synthetic superscripta to be used with this font, in pixels. Note, that this will generally be 
smaller than the size of the current font, i.e. superscripts are imaged from a smaller font, 
offset according to SUPERSCRIPr_X & SUPERSCRIPr_Y. 

SUPERSCRIPr_SIZE can be approximated if not provided as a font property, according to 
the algorithm: 

if (SUPERSCRIPT SIZE undefined) then 
SUPERSCRIPT_SIZE • CEIL(0.60 * PIXEL_SIZE) 

3.2.28 SUBSCRIPT _SIZE CARD32 

SUBSCRIPr_SIZE is an unsigned integer value that gives the recommended body size of 
synthetic subscripta to be used with this font, in pixels. As with SUPERSCRIPr_SIZE, this 
will generally be smaller than the size of the current font, i.e. subscripts are imaged from a 
sma1ler font, offset according to SUBSCRIPr_x & SUBSCRIPr_Y. 

SUBSCRIPr_SIZE can be approximated if not provided as a font property, according to the 
algorithm: 

if (SUBSCRIPT SIZE undefined) then 
SUBSCRIPT_SIZE • CEIL(0.60 * PIXEL_SIZE) 

3.2.29 SMALL_ CAP _SIZE CARD32 

SMALL_CAP _SIZE is an integer value that gives the recommended body size of synthetic 
small capitals to be used with this font, in pixels. Small capitals are generally imaged from 
a smaller font, of slightly more weight. No offset [X, Y] is necessary. 

SMALL_CAP _SIZE can be approximated if not provided as a font property, according to the 
algorithm: 

if (SMALL CAP SIZE undefined) then 
SMALL CAP SIZE • CEIL(PIXEL SIZE * ((X HEIGHT 

- - + ((CAP_HEIGHT - X_HEIGHT) I 3)) I CAP_HEIGHT)) 

3.2.30 UNDERLINE_POSITION INT32 

UNDERLINE_POSJTION is an integer value that gives the recommended vertical offset in 
pixels from the baseline to the top of the underline. If the current position point is at [X,Y), 
then the top of the baseline is given by [X, Y + UNDERLINE_POSITION]. 

UNDERLINE_POSITION can be approximated if not provided as a font property, according 
to the algorithm: 

if (UNDERLINE POSITION undefined) then 
ONDERLINE_POSITION • CEIL(max_bounds.descent I 2) 
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3.2.31 UNDERUNE_THICKNESS CARD32 

UNDERLINE_POSmON is an unsigned iuger value that gives the recommended underline 
thickneu. in pixels. 

UNDERLINE_THICKNESS can be approximated if not provided as a font property, according 
to the alprithm: 

CapStemWidth • average width of the stems of capitals 
if (UNDERLINE THICKNESS undefined) then 

UNDERLINE_THIC!CNESS • CapStemWidth 

3.2.32 STRIKEOUT _ASCENT INT32 

STRIKEOUT_ASCENT is an integer value that lives the vertical ascent for boxing or voiding 
glyphs in this font. If the current position is at [X, Yl and the string extent is EXTENT, 
then the upper-left comer of the strikeout box is at [X, Y - STRIKEOUT_ASCENTJ and the 
lower-right comer of the box is at [X +EXTENT, Y + STRIKEOUT_DESCENTJ. 

STRIKEOUT_ASCENT can be app10x:imated if not provided as a font p10perty, according to 
the algorithm: 

if (STRIKEOUT ASCENT undefined) 
STRIKEOUT_ASCENT • max_bounds.ascent 

3.2.33 STRIKEOUT _DESCENT INT32 

STRIKEOUT_DESCENT is an integer value that lives the vertical descent for boxing or 
voiding glyphs in this font. If the current position is at [X, Yl and the string extent is EXTENT, 
then the upper-left eomer of the strikeout boz is at [X, Y - STRIKEOUT_ASCENTJ and the 
lower-right comer of the box is at [X +EXTENT, Y + STRIKEOUT_DESCENTJ. 

STRIKEOUT_DESCENT can be approximated if not p10vided as a font p10perty, according 
to the algorithm: 

if (STRIKEOUT DESCENT undefined) 
STRIKEOUT_DESCENT • max_bounds.descent 

3.2.34 ITALIC_ANGLE INT32 
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ITALIC_ANGLE is an integer value that lives the nominal posture angle of the typeface 
design, in 1/64 deifeeS, measured from the glyph origin counterclockwise from the three 
o'clock positon. 

JTALIC_ANGLE can be defaulted if not p10vided as a font pnperty, according to the 
algorithm: 

if (ITALIC ANGLE undefined) then 
ITALIC_ANGLE • (90 * 641 
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3.2.35 CAP _HEIGHT CARD32 

CAP _llEIGHT ii an unsigned integer, the nominal height of the capital letters contained in 
the font, u specified by the FOUNDRY or typeface designer. Where applicable, defined to be 
the heicJat tL the Latin upper case letter X. 

CAP _HBIGHT is requi~ed by certain clients to compute scale factors and positioning ofFsets for 
algorithmically pnerated glyphs where this information or designed glyphs are not explicitly 
provided by the font (e.g., small capitals, superiors, inferiors, etc.). Capital height is also a 
critical factor in font ma.tching and substitution. 

CAP _HEIGHT can be approximated if not provided as a font property, according to the 
algorithm: 

if (CAP HEIGHT undefined) then 
if (latin font> then 

CAP HEIGHT • XCharStruct.ascent[glyph X] 
else If (capitals exist) then 

CAP HEIGHT • XCharStruct.ascent[some capital glyph] 
else CAP_HEIGHT undefined 

3.2.36 X_HEIGHT CARD32 

x_HEIGHT is a unsigned integer, the nominal height above the baseline of the lower case 
glyphs contained in the font, as specified by the FOUNDRY or typeface designer. Where 
applicable, defined to be the height of the Latin lower case letter %. 

Al& with Capital height, X_HEIGHT is required by certain clients to compute scale factors for 
algorithmically generated small capitals, where not explicitly provided by the font resource 
and is a critical factor in font matching and substitution. 

x_HEIGHT can be approximated if not provided as a font property, according to the algorithm: 

if (X HEIGHT undefined) then 
if Clatin font) then 

X HEIGHT• XCharStruct.ascent[glyph x] 
else if (lower case exists) then 

X HEIGHT • XCharStruct.ascent[some lower case glyph] 
else X_HEIGHT is undefined 

3.2.37 RELATIVE_SETWIDTH CARD32 

RELATIVE_SETWIDTH is an integer that gives the coded proportionate width of the font, 
relative to all known fonts of the same typeface family. accordinc to the type designer's or 
FOUNDRY's judgement. 

The po11ible values are: 

Table I: AELATIVE_SETWIDTH encodings 

Code BacHeh Strini De.cription 

0 

10 

ancllftned 

tntraConden•d 

- undefined or unknown 

- lowest ratio of average width to height 
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Table I (Cont.): FIELATIVE_SETWIDTH encodings 

20 BztraCiondeneed 

30 Condemed - Ciondenaed, Narrow, Compreued, ... 

40 SemiCondemed 

50 Medium - Medium, Normal, Regular, ... 

60 Semi Expanded - SemiE~ded, Demihpanded, ... 

70 Expanded 

80 Extra.Expanded - Extra.Expanded, Wide, ... 

90 UltraExpanded - hichut ratio of average width to heicht 

RELATIVE_$ETWIDTH can be defaulted if not provided as a font property, according to the 
algorithm: 

if (RELATIVE SETWIDTH undefined) then 
RELATIVE_SETWIDTH • 50 

X clients that wish to obtain a calculated proportionate width of the font (i.e. a font· 
independent way of identifying the proportionate width across all fonts and all font vendors), 
can use the following algorithm: 

SETWIOTH • AVG_CAPITAL_WIDTH I (CAP_HEIGHT * 10) 

where SETWIDTH is a real, with 0 being the •narrowest" calculated setwidth. 

3.2.38 AELATIVE_WEIGHT CARD32 
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RELATIVE_ WEIGHT is an integer that gives the coded weight of the font, relative to all 
known fonts of the same typeface family, according to the type designer's or FOUNDRY's 
judgement. 

The possible values are: 

Table 7: RELATIVE_ WEIGHT encodings 
CoU Bnsliah Strins o-cription 

0 undefined - undefined or unknown 

10 Ultral.icht - lowest ratio of stem width to heicht 

20 Extra.Licht 

30 Lisht 

40 Sem.iLicht - SemiLight, Book, ... 

60 Medium - Medium, Normal, Replar, ... 
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Table 7 (Cont.): RELATIVE_ WEIGHT ancodlng1 

Code Bqll•hStrinc DellOriptlon 

60 SmniBold - SmniBold. DemiBold, ... 

70 Bold 

80 Extra.Bold - Extra.Bold. Heavy, ... 

90 tntraBold - UltraBold. Black, ... , the highest ratio of st.em width to height 

RELATIVE_ WEIGHT can be defaulted if not. provided as a font property, according to the 
algorithm: 

if (RELATIVE WEIGHT undefined) then 
RELATIVE_WEIGHT • 50 

3.2.39 WEIGHT CARD32 

Calculated WEIGHT is an unsigned integer, the calculated weight of the font, computed as the 
ratio of capital stem width to CAP _HEIGHT, in the range 0 to 1000 where 0 is the "lightest• 
weight. 

WEIGHT can be calculated if not supplied as a font property, according to the algorithm: 

CapStemWidth • averaqe width of the stems of capitals 
if (WEIGHT undefined) then 

WEIGHT• CEIL ((CapStemWidth * 1000) I CAP_HEIGHT) 

A calculated value for weight is necessary when matching fonts from different families since 
both the RELATIVE_ WEIGHT and the WEIGHT_NAME are assigned by the typeface sup­
plier, according to its tradition and practice, and therefore somewhat subjective. Calculated 
WEIGHT provides a font-indepemknt way of identifying the weight across all fonts and all 
font vendors. 

3.2.40 RESOLUTION CARD32 (DEPRECATED) 

Independent horizontal and vertical design resolution components are required to accomodate 
displays with non-square aspect ratios, and are given by the RESOLUTION_x and RESO­
LUTION_Y font name fields/properties. The units of the original defintion of RESOLUTION 
are also in conflict with these new propet"ties. X clients are encouraged to discontinue usage 
of RESOLUTION and to use the appropriate X. Y resolution properties as required. 

3.2.41 FACE_NAME ATOM 

FACE_NAME is a human-understandable string that gives the full device-independent 
typeface name, including the owner, weight, slant, set, etc., but not the resolution, size, 
etc. Normally used as feedback during font selection. 

FACEJlAME can not be calculated or approximated if not provided as a font property. 
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3.2.42 COPYRIGHT ATOM 

COPYRIGHT ia a human-understandable atrinr that gives the copyright information of the 
legal owner of the digital font data. 

Thia information is a required component of a font, independent of the particular format used 
to represent it (i.e. it cannot be captured as a comment that could later be "thrown away" for 
efficiency reasons). 

COPYRIGHT can not be calculated or approximated if not provided as a font property. 

3.2.43 NOTICE ATOM 

NOTICE is a human-understandable string that gives the copyright information of the legal 
owner of the font design, or if not applicable, the trademark information for the typeface 
FAMILY_NAME. 

Typeface design and trademark protection laws vary from country to country, the USA having 
no design copyright protection currently, while various countries in Europe offer both design 
and typeface family name trademark protection. As with COPYRIGHT, this information is a 
required component of a font, independent of the particular format used to represent it. 

NOTICE can not be calculated or approximated if not provided as a font property. 

3.2.44 DESTINATION CARD32 

DESTINATION is an unsigned integer code that gives the font design destination, i.e. whether 
it was designed as a screen proofing font to match printer font glyph widths (WYSIWYG), as 
an optimal video font (possibly with corresponding printer font) for extended screen viewing 
(VideoText), etc. 

The font design considerations are very different, and at current display resolutions, the 
readability and legibility of these two kinda of screen fonta are very different. DESTINATION 
allows publishing clients which use X to model the printed page, and Video Ten clients such 
as on-line documentation browsers, to query for X screen fonts that suit their particular 
requirements. 

The encoding is as follows: 

Table 8: DESTINATION encodings 
Code Enrliah Strinr De.eription 

0 WYSIWYG - a font optimized to match the typographic design and metrics of an 
equivalent printer font 

1 Video 'Dtzt - a font optimized fOT ac:reen ltlibility *'lld readability 

3.3 Bullt-ln Font Property atoms 
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, The following font property atom definitions were predefined in the initial Version 11 of the 
X protocol: 



(" Table 9: Bulft·ln Font Property Atoms 

Font Property Atom Name Property Type 

MIN_SPACE MIN_SPACE_ATOM CARD32 

NORM_SPACE NORM_SPACE_ATOM CARD32 

MAX_SPACE MAX_SPACE_ATOM CARD32 

END_SPACE END_SPACE_ATOM CARD32 

SUPEMCRIPT_X SUPEMCRIPT_X,_ATOM INT32 

SUPEMCRIPT_Y SUPEMCRIPT_Y_ATOM INT32 

SUBSCRIPT_X SUBSCRIPT_X,_ATOM INT32 

SUBSCRIPT_Y SUBSCRIPT_Y_ATOM INT32 

UNDERLINE_ UNDERLINE_POSITION_ INT32 
POSITION ATOM 

UNDERLINE_ UNDERLINE_ THICKNESS_ CARD32 
THICKNESS ATOM 

STRIKEOUT_ASCENT STRIKEOUT_ASCENT_ATOM INT32 

STRIKEOUT_ STRIKEOUT_DESCENT_ATOM INT32 
DESCENT 

FONT_ASCENT FONT_ASCENT_ATOM INT32 

FONT_DESCENT FONT_DESCENT_ATOM INT32 

( ITALIC_ANGLE ITALIC_ANGLE_ATOM INT32 

X_HEIGHT X_HEIGHT_ATOM INT32 

QUAD_ WIDTH QUAD_ WIDTH_ATOM INT32 -deprecatl!d 

WEIGHT WEIGHT_ATOM CARD32 

POINT_SIZE POINT_SIZE_ATOM CARD32 

RESOLUTION RESOLUTION_ATOM CARD32 -deprecated 

COPYRIGHT COPYRIGHT_ATOM ATOM 

FACE_NAME FACE_NAME_ATOM ATOM 

FAMILY_NAME FAMILY_NAME_ATOM ATOM 

DEFAULT_CHAR DEFAULT_CHAR_ATOM CARD32 
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4 Affected elements of XLIB and the X protocol 
The tollowina X protocol requests must use the font naming conventions: 

• Open.Font-for the name parameter 

• Udl'on.ts-f'or the pattem parameter 

• ListFontsWithlnfo-for the pattem parameter 

In addition, the following XLIB functions must use the font naming conventions: 

• XLoad.Font-for the name parameter 

• XLiBtFon.tsW'uhJnfo-for the pattem parameter 

• XLoadQu.eryFont-for the name parameter 

• XListFonts-for the pattem pal'8meter 

5 BDF Conformance 
The bitmap font distribution and interchange format adopted by the X Consortium (BDF 
V2. l) provides a general mechanism for identifying the font name of an X font and a variable 
list of font properties, but does not mandate the syntax/semantics of the font name or the 
semantics of the font properties that might be provided in a BDF font. This section identifies 
the requirements for BDF fonts that conform to XLFD. 

5.1 XLFD Conformance Requirements 

A BDF font conforms to the XLFD Vl.2 specification if and only if the following conditions 
are satisfied: 

• the value for the BDF item FONT conforms to the syntax and semantic definition of a 
XLFD FontName string; 

• the FontName begins with the X FontNameRegistry prefix: "·"; 

• all XLFD FontName fields are defined; 

• any FontProperties provided conform in name and semantics to the XLFD FontProperty 
definitions. 

A simple method of testing for conformance would entail fint verifying that the Font­
NameRegistry prefix is the string"-•, that the number of field delimiters in the string and 
coded field values are valid, and that each font property name either matches a standard 
XLFD property name or follows the definition of a private property. 

5.2 FONT_ASCENT, FONT_DESCENT and DEFAULT_CHAR 
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FONT.,MCENT, FONT_DESCENT and DEFAULT_CHAR are povided in the BDF specifica­
tion u properties that are moved to the XFontStruct by the BDF font compiler in generating 
the X atrver-specific binary font encoding. If present, these properties shall follow the follow­
ing semantic definitions: 
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5.2.1 FONT _ASCENT INT32 

FONT_ASCENT is an unsigned integer that gives the recommended typographic ascent above 
the baseline, for determining interline spacing. Specific glyphs of the font may extent beyond 
this. If the current position point for linen is at [X,Y], then the origin of the next line n+1 
(allowiq for a possible font change) is [X, Y + FONT_DESCENT n + FONT_ASCENT n+tl· 

FONT_ASCENT can be approximated if not provided as a font property, according to the 
algorithm: 

if (FONT ASCENT undefined) then 
FONT_ASCENT • max_bounds.ascent 

5.2.2 FONT_DESCENT INT32 

FONT_DESCENT is an unsigned integer that gives the recommended typographic descent 
below the baseline, for determining interline spacing. Specific glyphs of the font may extent 
beyond this. If the current position point for line n is at [X, Yl, then the origin of the next line 
n+1 (allowing for a possible font change) is [X, Y + FONT_DESCENT n + FONT_ASCENT 
n+1l. 

The logical extent of the font is inclusive between the Y-coordinate values: Y - FONT_ASCENT 
and Y + FONT_DESCENT + 1. 

FONT_DESCENT can be approximated if not provided as a font property, according to the 
algorithm: 

if (FONT DESCENT undefined) then 
FONT_DESCENT • max_bounds.descent 

5.2.3 DEFAULT_CHAA CARD32 

DEFAULT_CHAR is an unsigned integer value that gives the default character to be used by 
the X server when an attempt is made to display an undefined or non-existent character in 
the font. 

The DEFAULT_CHAR is a 16-bit character (not a two byte character). For a font using two 
byte matrix format, the DEFAULT_CHAR has bytel in the most significant byte and byte2 
in the least significant byte. If the DEFAULT_CHAR itself is undefined or it specifies an 
undefined or non-existent character in the font, then no display is performed. 

DEFAULT_CHAR can not be approximated if not provided as a font property. 

6 Typeface Copyrights 
Helvetica, 7lmes are registered trademarks of Linotype Company. 

ITC Avant Garde Gothic is a registered trademark of International Typeface Corporation. 

7lmet Roman is a registered trademark of Monotype Corporation. 

Bitstream Amerigo is a registered trademark of Bitstream Inc. 

Stone is a registered trademark of Adobe Systems Inc. 

(end] 
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Character Conversion Charts 

s INCE X WINDOW SYSTEM AND MACINTOSH APPLICATIONS USE OIFFEl!ENT 

character sets,.Malcolm must translate any data transmitted between ... 

(To be supp/led later.) 

Appendix E: Character Conversion Charts 159 
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